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บทคัดย่อ 
 

 โครงงานวิจัยนี้มีจุดประสงค์หลักคือ เพ่ือจัดตารางการอบของผลไม้อบแห้งโดยใช้แบบจ าลอง
สถานการณ์อารีน่า เริ่มจากการศึกษากระบวนการผลิตผลไม้อบแห้งทั้งสามชนิด ท าการส ารวจและท าการจับ
เวลาในแต่ละกระบวนการผลิตผลไม้อบแห้งทั้งสามชนิด จากนั้นจึงน ามาสร้างแบบจ าลองสถานการณ์โดยใช้
โปรแกรมสร้างแบบจ าลองสถานการณ์อารีน่าเพ่ือสร้างแบบจ าลองให้สามารถผลิตผลไม้ได้หลายชนิดในหนึ่ง
กระบวนการผลิตจากนั้นจึงน ามาวิเคราะห์หารูปแบบโมเดลของกระบวนการผลิตผลไม้อบแห้งที่จะใช้งานตู้อบ
ให้ได้มีประสิทธิภาพที่สุด 
 โครงงานวิจัยครั้งนี้พบว่ากระบวนการผลิตมีคอขวดที่กระบวนการอบผลไม้อบแห้ง ซึ่งทางผู้วิจัยจึงสร้าง
แบบจ าลองสถานการณ์ขึ้นมาเพ่ือเป็นแนวทางให้ผู้ผลิตได้ใช้ตู้อบให้มีประสิทธิภาพมากที่สุดโดยได้ท าการ
น าเสนอโมเดลแบบจ าลองขึ้นมา 3 วิธีด้วยกันคือ ท าการผลิตผลไม้อบแห้งเพียงชนิดเดียวทีละกระบวนการ
ผลิตแบบเดิม ท าการผลิตผลไม้อบแห้งทีละสองชนิด ดังนี้ มะม่วงและล าไย, มะม่วงและมะเขือเทศ, ล าไยและ
มะเขือเทศ เพ่ือจัดการตารางการน าเข้าผลไม้แต่ละชนิดเพ่ือเข้าการอบโดยที่มีตู้อบแปดตู้จึงสามารถจัดสรร
ล าดับการอบผลไม้ได้อย่างอิสระ ท าการผลิตผลไม้อบแห้งทั้งสามชนิดพร้อมกันและดูแนวทางความเป็นไปได้ใน
การจัดการตารางการน าเข้าผลไม้แต่ละชนิดเพ่ือเข้าการอบ โดยหลังจากสร้างแบบจ าลองสถานการณ์แล้วจะ
น าค่าที่ได้จากแบบจ าลองมาตรวจสอบเพ่ือให้มั่นใจว่าสามารถท าได้จริงและจึงจะน าเสนอเป็นแนวทางในการ
ผลิต 
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ABSTRACT 
 

 The main objective of this project is to schedule fruit drying using the situation model 
to study the process of all three kinds of dried fruit production, Then the model was created 
by using the Arena Situation Modeling Program to create a model that can produce many 
kinds of fruit in one production process, then analyze the model of the dried fruit production 
process at Will use the oven as efficiently as possible. 
 This research project found that the production process has bottlenecks in the 
process of drying fruit drying. The researcher therefore created a situation model to guide the 
manufacturer to use the oven as efficiently as possible by presenting 3 model, which are one 
type of dried fruit is produced, one by one, in the original production process. Dried fruits are 
produced in two types as follows: Mango and Longan, Mango and Tomatoes, Longan and 
Tomatoes To manage the import schedule of each type of fruit for baking, with eight ovens, 
it is possible to freely allocate the drying sequence of the fruits, Produce all three kinds of 
dried fruits at the same time and look at the possibility of managing the import schedule of 
each type of fruit for drying. After creating the model, the values from the model will be 
inspected to ensure that it can be done and will therefore be presented as a production guide. 
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บทท่ี 1 

 

บทน า 

 

1.1 ความส าคัญและที่มาของของปัญหาที่ท าโครงงาน 
 
การแปรรูปโดยการน าผลไม้ผ่านกระบวนการอบแห้งเป็นวิธีการแปรรูปชนิดหนึ่งซึ่งเป็นที่นิยม

กันมากและสามารถน ามาผลิตในระดับอุตสาหกรรมได้และสามารถจ าหน่ายภายในประเทศและ
ส่งออกไปยังต่างประเทศในลักษณะเป็นอาหารเพ่ือการบริโภคในลักษณะอาหารว่างและรับประทาน
เล่นซึ่งยังคง กลิ่นและรสธรรมชาติของผลไม้ชนิดนั้นอยู่  ปัจจุบันธุรกิจผลไม้อบแห้งมีการเติบโตขึ้น
อย่างต่อเนื่อง ซึ่งวิสาหกิจชุมชนแปรรูปผลิตภัณฑ์เกษตรบ้านล่ามช้าง ก่อตั้งขึ้นในปี พ .ศ .2557 เกิด
จากการรวมตัวกันของเกษตรกรชาวบ้านจัดตั้งกลุ่มแปรรูปผลผลิตทางการเกษตร เพ่ือเพ่ิมมูลค่าให้กับ
ผลผลิตทางการเกษตร ซึ่งเกษตรกรทุกคนที่เป็นสมาชิกกลุ่มเป็นเจ้าของกิจการ และได้รวบรวม
ผลผลิตทางการเกษตรที่ได้คัดสรรคุณภาพ ทั้งจากสมาชิกและไม่ใช่สมาชิก เพ่ือน ามาแปรรูปเป็น
ผลิตภัณฑ์ผลไม้อบแห้ง โดยผลิตภัณฑ์หลักของวิสาหกิจชุมชนบ้านล่ามช้าง  ได้แก่ กล้วยอบแห้ง 
มะม่วงอบแห้ง ล าไยอบแห้ง แก้วมังกรอบแห้ง ดังตัวอย่างภาพ 1.1  

 
 
 

 
 
 
 
 
 
 

ภาพ 1.1 ผลิตภัณฑ์หลักของวิสาหกิจชมุชนบ้านล่ามช้าง 
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จากการส ารวจข้อมูลเบื้องต้นทางวิสาหกิจชุมชนบ้านล่ามช้าง มีปัญหาที่พบคือ มีการรอคอย
งานในกระบวนการผลิตที่ท าให้เกิดการสูญเสียเวลาในกระบวนผลิต เกิดการผลิตมากเกินไป (Over 
production) ในบางขั้นตอนของกระบวนการผลิตท าให้มีงานระหว่างท า (Work in process, WIP)
ในกระบวนเป็นจ านวนมาก ดังนั้นผู้วิจัยจึงได้สนใจการประยุกต์ใ ช้แบบจ าลองสถานการณ์ 
(Simulation) ด้วยโปรแกรมอารีนา เพ่ือช่วยหาแนวทางในปรับปรุงกระบวนการผลิตเพ่ือลดความ
สูญเสียที่เกิดจากกระบวนการผลิตที่เกิดข้ึน 

 
1.2 วัตถุประสงค์ 
 

จัดตารางการอบผลไม้อบแห้งแบบหลายชนิดพร้อมกันโดยใช้แบบจ าลองสถานการณ์ 
 

1.3 ขอบเขตการศึกษา 
 

1.3.1 ท าการศึกษา ณ วิสาหกิจชุมชนแปรรูปผลิตภัณฑ์เกษตรบ้านล่ามช้าง 
1.3.2 ศึกษากระบวนการผลิตของผลไม้อบแห้งของผลไม้อบแห้งอย่างน้อยสามชนิด เริ่มจาก

กระบวนการจัดเตรียมวัตถุดิบ กระบวนการอบ กระบวนการบรรจุผลิตภัณฑ์ เพ่ือน าไปสร้าง
แบบจ าลองโดยโปรแกรมจ าลองสถานการณ์อารีน่า  
 
1.4 ประโยชน์ที่คาดว่าจะได้รับ 

 
1.4.1 ได้สร้างแบบจ าลองสถานการณ์ของกระบวนการผลิตผลไม้อบแห้ง 
1.4.2 ได้น าเสนอแนวทางการจัดตารางการอบผลไม้อบแห้งแบบหลายชนิดพร้อมกันโดยใช้

แบบจ าลองสถานการณ์ ที่สร้างด้วยโปรแกรมอารีน่าและเปรียบเทียบแบบจ าลองกระบวนการผลิต
แบบเก่าและใหม ่
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บทท่ี 2 

 

หลักการและทฤษฎีที่เกีย่วข้อง 

 

 

2.1 ทฤษฎีเกี่ยวกับแบบจ าลองสถานการณ์ 
 

แบบจ าลองสถานการณ์ (Simulation) คือ การน าเสนอหรือการจ าลองลักษณะของระบบอ่ืนๆ 
ตลอดช่วงเวลาที่สนใจ โดยวิธีการสร้างตัวแบบจ าลองทางคณิตศาสตร์ของระบบงานนั้น และศึกษา 
สังเกต หรือทดสอบแบบจ าลองนั้นในช่วงเวลาหนึ่ง เพ่ืออธิบายพฤติกรรมของระบบงานและ
ผลกระทบเมื่อมีการเปลี่ยนแปลงเกิดขึ้น แบบจ าลองสถานการณ์ จึงเป็นเครื่องมือช่วยในการ
บริหารงานและทดสอบทางเลือกต่างๆ เพ่ือตัดสินใจเลือกทางที่ดีที่สุด เทคนิคการจ าลองสถานการณ์
ถูกน ามาใช้อย่างแพร่หลายเพื่อแก้ปัญหาเนื่องจาก 

วิธีการจ าลองสถานการณ์เป็นเพียงวิธีการเดียวที่จะน าไปใช้ได้เนื่องจากการศึกษา หรือ
วิเคราะห์จากระบบจริงทั้งระบบเป็นเรื่องยาก 

ยากท่ีจะหาค าตอบด้วยวิธีเชิงปริมาณธรรมดา 
การศึกษาจากระบบจริงเสียค่าใช่จ่ายสูงและเสียเวลามา  

การทดสอบหรือสังเกตจากระบบจริงทั้งระบบ มีวิธีการที่แตกต่างกันมากเกินไปยุ่งยากใน
การศึกษา  
ระบบ Simulation จะแบ่งเป็นสี่ส่วนหลักๆคือ 

Computer Simulation คือ โปรแกรมคอมพิวเตอร์ที่จ าลองลักษณะการท างานของระบบที่
สนใจตลอดเวลาหรือเฉพาะช่วงเวลาที่ให้ความสนใจ 

Program variable หรือ State variable เป็นตัวแปรซึ่งใช้เป็ฯสื่อกลางในการแสดงถึง
สถานะปัจจุบันของระบบที่จ าลอง 

simulation Program จะเปลี่ยนค่าของ State variable เพ่ือที่จะน าไปพัฒนาแบบจ าลอง
ไปตามช่วงเวลาที่เปลี่ยนแปลงไปเรื่อยๆ 

รูปแบบของเวลาที่มีการใช้งานในระบบ Simulation 
การท า งานออกเป็นสองประเภท คื อ  Continuous time simulation และ  discrete time 
simulation โดยที่แต่ละแบบนั้นจะมีลักษณะการท างานที่แตกต่างกัน การเลือกใช้จึงควรเลือกให้
เหมาะกับลักษณะของงาน 
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2.1.1 Continuous time simulation Continuous time simulation เป็นระบบ
จ าลองที่ให้ความสนใจการเปลี่ยนแปลงในแบบจ าลองตลอดเวลาตั้งแต่เริ่มต้นท างานจนสิ้นสุดการ
ท างาน ไม่ว่าระหว่างการท างานของ แบบจ าลองจะมีการเปลี่ยนแปลงหรือไม่มีการเปลี่ยนแปลงใดๆ
เกิดขึ้นก็ตาม ซึ่งลักษณะของ แบบจ าลองที่ได้มักจะขึ้นกับสมการที่จะน ามาใช้ในการอธิบาย
แบบจ าลอง แบบจ าลองที่เหมาะสม กับการท างานแบบนี้ มักจะเป็นแบบจ าลองที่ต้องการความ
ต่อเนื่องในการท างาน   

2.1.2 Discrete time simulation discrete time simulation เป็นระบบจ าลองที่
ให้ความสนใจการเปลี่ยนแปลงใน ลักษณะเป็นช่วงของเวลาที่ ไม่ต่อเนื่อง คือ ไม่ต้องเก็บข้อมูล
ตลอดเวลาทีจ่ าลองการท า งาน ซึ่งสามารถแบ่งเป็นรูปแบบย่อยๆ ได  ้2 รูปแบบ คือ  

- Event stepped เป็นแบบจ าลองที่ จะสนใจต่อเหตุการณ์ที่ มีการ
เปลี่ยนแปลงไป ดังนั้นการเลื่อนไปของเวลาที่ใช้ในแบบจ าลองจะขึ้นอยู่กับการเกิดเหตุการณ์ต่างๆ 
หากมีเหตุการณ์ใด เหตุการณ์หนึ่งเกิดขึ้นจึงจะมีการเลื่อนไปของเวลา แบบจ าลองที่มีความเหมาะสม 
เช่น แบบจ าลอง ของสนามบินอย่างง่ายซึ้งจะสนใจการขึ้นและลงของเครื่องบิน นั้นคือจะมีการ
เปลี่ยนแปลงเมือ่ เครื่องบินมีการบินขึ้นและบินลงในสนามบิน 

- Time stepped เป็นแบบจ าลองท่ีจะเก็บขอ้มูลเป็นช่วงๆ ของเวลา ดังนั้น
เวลาที่จะใช้ในการ ท างานจะมีการเลื่อนไปด้วยอัตราคงที่ ซ่ึงจะขึ้นอยู่กับการก าหนดของแบบจ าลอง 
เช่น แบบจ าลอง การเปลี่ยนแปลงระดบัน้ าของทะเล ซึ้งจะเก็บการเปลี่ยนแปลงทุกๆ ครึ่งชั่วโมง 

โปรแกรมอารีน่า (Arena) คือ เป็นซอฟต์แวร์ที่ใช้สร้างโมเดลจ าลอง ของปัญหาเพ่ือให้เห็นถึง
ผลดี ผลเสีย และให้ได้ทางเลือกท่ีดีที่สุดก่อนลงมือปฎิบัติจริง สามารถจ าลองได้หลายรูปแบบเพ่ือช่วย
ในการวิเคราะห์พฤติกรรมและวัดผลการท างานที่เกิดขึ้นให้มีประสิทธิภาพมากสุด ซึ่งจะช่วยลดความ
เสี่ยงในส่วนที่กระทบกับการท างานจริง ช่วยลดต้นทุนในการด าเนินงาน ท าให้เกิดการใช้ทรัพยากรได้
อย่างคุ้มค่าโดยที่ประโยชน์ของ อารีน่า มีดังนี ้

สามารถใช้อารีน่าสร้างโมเดลที่เก่ียวข้องกับกระบวนการทางธุรกิจ 
สามารถน าผลลัพธ์จาก แบบจ าลองสถานการณ์อารีน่า มาช่วยวิเคราะห์และแก้ไข

ปัญหาได้อย่างถูกวิธีเพ่ือป้องกันความผิดพลาดในการวางแผนปรับเปลี่ยนนโยบายการท างาน 
สามารถใช้อารีน่าช่วยวิเคราะห์และทดลองการปรับเปลี่ยนจ านวนพนักงาน

ให้บริการที่เหมาะสม เพ่ือลดปัญหาการรอคอย 
สามารถใช้อารีน่าสร้างโมเดลที่เกี่ยวข้องกับการขนส่งสินค้า และปรับเปลี่ยนเส้นทาง

การขนส่ง เช่น re-route, re cluster เพ่ือหาต้นทุนการขนส่ง 
สามารถใช้อารีน่าสร้างโมเดล ที่เกี่ยวข้องกับการขนย้าย )Material Handling) 

บริเวณท่าเรือขน container หรือโกดังสินค้า เป็นต้น 
สร้าง แอนิเมชั่น ช่วยให้ผู้บริหารสามารถมองเห็นภาพและเพ่ิมความเชื่อมั่นในการ

ตัดสินใจ 
หาระยะเวลาของการผลิต (Process time), รอบการผลิต (Cycle time), แนวทาง

ลดช่วงเวลาการผลิต (Manufacturing lead time) และความเสี่ยงในการลงทุน เป็นต้น 
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ช่วยทดสอบหาคอขวด ในระบบ และเพ่ิม การใช้ประโยชน์ (Utilization) 
ช่วยท าการจัดสมดุลการผลิตและหาขนาดชุดการสั่งซื้อ ที่เหมาะสม 
แผนเพิ่มประสิทธิภาพ 

 
2.1.3 การศึกษาการท างาน (Work Study) 

  การศึกษาการท างาน (Work Study) คือการศึกษาวิธี (Method Study) และการ
วัดผลงาน (Work Measurement) ซึ่งใช้ในการศึกษากระบวนการท างานและองคป์ระกอบต่างๆเพ่ือ
ปรับปรุง การท างานใหดีขึ้น และใชประโยชนด้านการพัฒนามาตรฐานของการท างานและเวลาท างาน 
รวมไปถงึการใช้เป็นเครื่องมือในการพัฒนาส่งเสริมจูงใจบุคลากรน าไปสูการเพ่ิมผลผลิต 
 
   2.1.4 การศึกษาวิธีการท างาน (Method Study) หมายถึงการศึกษาวิธีการท างาน
จากการบันทึก และวิเคราะห์วิธีการท างานขององค์การทีก่ าลังท าอยู่ เพ่ือเสนอวิธีการท างานแบบใหม่
อย่างมรีะบบ และประยุกต์ใช้เป็นเครื่องมือในการท างานใหมีประสิทธิภาพและประสิทธิผล การศึกษา
วิธีการ ท างานจะช่วยให้เกิดการปรับปรุงกระบวนการในการท างาน ให้ มีความเหมาะสมกับการ
ปฏิบัติงาน  
ขั้นตอนของการศึกษาวิธีการท างานพอสรุปได้ดังนี้  

การเลือกงาน 
การเก็บข้อมูลวิธีการท างาน 
การวิเคราะห์วิธีการท างาน 
การปรับปรุงวิธีการท างาน  
การเปรียบเทียบวัดผลการท างาน 
การพัฒนามาตรฐานวิธีการท างาน 
การส่งเสริมใช้วิธีการท างานที่ปรับปรุงแล้ว 
การติดตามการใช้วิธีการท างานที่ปรับปรุงแล้ว 

 
            2.1.5 แผนภูมิกระบวนการผลิต (Process Chart) ซึ่งเป็นเครื่องมือที่ ใช้บันทึก
กระบวนการผลิตหรือวิธีการท างานให้อยู่ในลักษณะที่เห็นได้ชัดเจนและเข้าใจได้ง่าย ในแผนภูมินี้จะ
แสดงถึงขั้นตอนการท างานตั้งแต่ต้นจนจบกระบวนการ โดยจะเริ่มเขียนตั้งแต่รับวัตถุดิบเข้ามาถึง
โรงงาน แล้วติดตามบันทึกเหตุการณ์ที่เกิดขึ้นกับวัตถุดิบนั้นไปเรื่อย ๆ ทุกขั้นตอน เช่น ถูกล าเลียงไป
ยังห้องเก็บ ถูกตรวจสอบ ถูกเปลี่ยนรูปร่างโดยเครื่องจักร จนกระทั่งเป็นชิ้นส่วนหรือน าไปประกอบ
เป็นผลิตภัณฑ์ ในแผนแผนภูมิกระบวนการผลิตจะใช้สัญลักษณ์แสดงถึงความหมายต่าง ๆซึ่งสามารถ
ดัดแปลงเพื่อน าไปใช้กับงานอย่างอ่ืนได้ 

Operation  การใช้มือ หยิบ จับ จัดวาง หรือปล่อยสิ่งของ 
            Transportation  การเคลื่อนมือจากจุดหนึ่งไปยังจุดหนึ่ง  
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            Delay   การที่มือว่างโดยไม่ได้ท าอะไร  
            Hold   การถือของในมือเพ่ือรองานหรือให้มืออีกข้างหนึ่งท างาน 
             

2.1.6การจับเวลาโดยตรง (Direct Time Study) เพ่ือหาเวลาส่วนงานย่อย โดยใช้การจับ
เวลาอย่างแม่นย าซึ่งจะต้องมีการแบ่งงาน และมีการก าหนดเวลา มาตรฐานไว้ด้วย  
 
2.2 การสร้างแบบจ าลองสถานการณ์ด้วยโปรแกรมอารีน่า (Arena) 
  

เมื่อเข้าสู่โปรแกรมอารีน่า (Arena) จะพบหน้าต่างการท างานซึ่งประกอบไปด้วย Project 
bar ส่วนนี้ใช้ส าหรับมองหาหน่วยประกอบต่างๆ ซึ่งแต่ละหน่วยประกอบจะเรียกว่า โมดูล (Module) 
มีไว้ส าหรับการสร้างแบบจ าลองสถานการณ์โดยแบ่งออกเป็นสองส่วนคือ Flowchart module ใช้
ส าหรับจ าลองโครงสร้างขั้นตอนการท างานของระบบและ Spreadsheet module ซึ่งเป็นหน่วยที่ใช้
เก็บข้อมูลต่างๆ ที่สามารถน ามาค านวณเพ่ือประมวลผลในแบบจ าลองสถานการณ์ 
 Flowchart view คือส่วนที่ใช้แสดงการเชื่อมต่อของ Flowchart module ใช้ส าหรับการ
สร้างแบบจ าลองสถานการณ์เพ่ือแสดงกระบวนการทั้งหมดของระบบและสร้างภาพเคลื่อนไหวให้กับ
ระบบจ าลองสถานการณ์อีกด้วย 
 Spreadsheet view เป็นส่วนที่ใช้ส าหรับการใส่ข้อมูลซึ่งจะสัมพันธ์กับโครงสร้างเสมอและ
จากรายละเอียดข้างต้นสามารถแสดงตัวอย่างของแบบจ าลองสถานการณ์ได้ดังภาพ 2.1 
 
 

 
 

ภาพ 2.1 แสดงหน้าต่างของโปรแกรมอารีนา (Arena) 
จากภาพ 2.1 สามารถแสดงตัวอย่างการท างานของแบบจ าลองสถานการณ์ได้ดังภาพ 2.2  
 

Project 

Status 

bar 

Model window 

Flowchart view 

Spreadsheet 

view 
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ภาพ 2.2 แสดงตัวอย่างการจ าลองสถานกาณ์ของ Flowchart view 
 
 โดยในขั้นตอนแรกใส่ create module เป็นหน่วยโครงสร้างใช้ส าหรับเริ่มต้นสร้าง Entity 
เข้ามาในแบบจ าลอง เช่น รับวัตถุดิบผลไม้ เวลาของการท างานในส่วนต่างๆเป็นต้น ดังภาพ 2.3 
 

 
 

ภาพ 2.3 แสดงตัวอย่างหน้าต่าง create module 
 
จากภาพข้างต้นสามารถอธิบายข้อมูลเพิ่มเติมในส่วนของหน้าต่าง Create module ได้ดังนี ้

 - Name  คือชื่อที่ใส่ไว้และจะไปปรากฎใน Module 
   - Entity  คือการตั้งชื่อให้กับวัตถุที่เข้ามาในโมดูล 
   - Type  คือการเลือกประเภทของการมาถึงของวัตถุและมีให้เลือก
ถึง 4 ประเภทคือการมาแบบสุ่ม แบบคงท่ี แบบมีตารางเวลาการมาถึงของวัตถุและแบบสูตร 
   - Value  คือการใส่ค่าช่วงเวลาห่างของการมาถึง กรณีเลือก
ประเภทสูตรในช่องนี้จะใช้ใส่การแจกแจงที่ต้องการแทน 
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   - Unit  คือการเลือกหน่วยเวลาของช่วงเวลาการมาถึงตามค่าที่ใส่
ใน Value โดยมีหน่วยวินาที นาที ชั่วโมง และเลือกวันได้ 
   - Schedule คือกรณีเลือกประเภทแบบมีตารางเวลาการมาถึงของวัตถุ
จะไม่มีช่อง Value และ Unit ปรากฎแต่จะมีช่องตารางชื่อตารางเวลาการมาถึงของวัตถุปรากฎอยู่
แทนไว้ 
   - Entities คือการใส่จ านวนวัตถุที่มาถึงระบบในช่วงเวลาที่ก าหนดไว้
ต่อครั้งของการมาถึง ระบบทั่วไปจะมีหนึ่งวัตถุมาถึงและมาห่างกันในช่วงเวลาเที่ก าหนดแต่ในบาง
ระบบวัตถุมีหลายวัตถุพร้อมกัน 
 
 จากการสร้าง Process module เพ่ือน าวัตถุเข้ามาเพ่ือน าวัตถุเข้ามาท างานในระบบ
สายการผลิตโดยใส่ข้อมูลใน Process module เพ่ือก าหนดเวลาในการท ากิจกรรมและระบุรายชื่อ
ทรัพยากรที่เรียกใช้ ดังภาพ 2.4  
 

 
 

ภาพ 2.4 แสดงตัวอย่างหน้าต่าง Process Module 
 
จากข้างต้นจะอธิบายข้อมูลที่ต้องใส่ของ Process Module 
- Name   คือชื่อที่ใส่ไว้ในช่องนี้และจะไปปรากฎชื่อบนโมดูล 
- Type    คือการเลือกประเภทของคุณลักษณะเฉพาะของระบบภายในโมดูลมีให้เลือก 2 
ประเภท คือ Standard หรือ Submodel 
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- Action   คือปฎิบัติการของกระบวนการที่เกิดขึ้นภายในโมดูล มีให้เลือก 4 ปฏิบัติการซึ่ง
หน้าต่างนี้จะไม่ปรากฏขึ้นถ้าเลือกประเภทของระบบภายในโมดูลแบบ Submodel 
- Delay    คือปฏิบัติการที่อาศัยช่วงเวลา ในการท ากิจกรรมแต่ไม่ต้องการทรัพยากร 
- Seize Delay   คือปฏิบัติการจองจ านวนทรัพยากรมาท ากิจกรรมร่วมกับวัตถุ โดยอาศัยช่วงเวลา 
Delay ในการท ากิจกรรมและเมื่อกิจกรรมนั้นเสร็จสิ้น จะมีการปล่อยทรัพยากรให้ว่างเพ่ือใ ห้
ทรัพยากรนั้นสามารถท ากิจกรรมกับวัตถุกับวัตถุถัดไปได้ 
- Delay Release คือปฏิบัติการที่อาศัยช่วงเวลาในการท ากิจกรรมและเมื่อกิจกรรมนั้นเสร็จสิ้น จะมี
การปล่อยทรัพยากรให้ว่างโดยการเพิ่มหน้าต่างทรัพยากรเข้ามาจากนั้นระบุชื่อทรัพยากรที่ต้องการส่ง
ต่อให้วัตถุอ่ืนเรียกใช้ทรพยากรได้ 
- Priority  คือล าดับความส าคัญของวัตถุที่รอคอยเพ่ือเรียกใช้ทรัพยากรในโมดูล 
- Delay Type  คือประเภทของช่วงเวลาที่ใช้การท ากิจกรรม โดยจะมี 5 ประเภทซึ่งอยู่ในรูปของ
ลักษณะการแจกแจงช่วงเวลาการท ากิจกรรม ดังนี้ 
 Constant  คือเวลาที่ใช้ในการท ากิจกรรมเป็นคงที ่
 Normal    คือเวลาที่ใช้ในการท ากิจกรรมเป็นนอร์มอล 
 Triangular  คือเวลาที่ใช้ในการท ากิจกรรมเป็นแบบสามเหลี่ยม 
 Uniform  คือเวลาที่ใช้ในการท ากิจกรรมเป็นแบบยูนิฟอร์ม 
 Expression คือการเลือกรูปแบบของการแจกแจงที่ไม่ปรากฏข้างต้น โดยช่องนี้ผู้สร้างต้อง
สร้างต้องใส่ค่าให้ตัวแปรเสริม (Parameters) ที่จ าเป็นเข้าไปเพื่อเข้าให้ท าให้ข้อมูลแจกแจงสมบูรณ์ 
- Units             คือการเลือกหน่วยเวลาที่ใช้ในการท ากิจกรรมโดยมีหน่วย วินาที นาที ชั่วโมง วัน 
- Allocation     คือการเลือกก าหนดวิธีจัดสรรเวลาให้กับวัตถุดิบว่ากระบวนการที่เกิดขึ้นกับ
วัตถุดิบควรได้รับการจัดสรรไปสู่ข้อมูลใด 
- Record Entity  คือถ้ามีการคลิกเครื่องหมายถูกที่นี่ แสดงถึงการก าหนดให้บันทึกลงไปในรายงาน
ผลด้านมูลค่าเพ่ิมทางสถิติของตัววัตถุดิบให้บันทึกลงในรายงานผลด้านกระบวนการ 
 
ข้อมูลที่ต้องใส่ในหน้าต่าง Resource 
  - Type   คือการเลือกประเภทของทรัพยากรแบบระบุชื่อทรัพยากร
หรือกลุ่มทรัพยากร 
   - Resource name คือการระบุชื่อของทรัพยากรที่จะถูกใช้หรือ
ปล่อยออก ช่องนี้จะปรากฎเมื่อเลือกประเภทของทรัพยากรเป็นแบบระบุชื่อทระพยากร 
   - Set name   คือระบุชื่อของทรัพยากรที่สมาชิกจะถูกใช้หรือ
ปล่อยออกมาซึ่งช่องนี้จะปรากฏออกมาก็ต่อเมื่อเลือกประเภทของทรพยากรเป็นแบบกลุ่มทรัพยากร 
(Set)  
   - Selection Rule  คื อกฎ ในการ เ รี ยก ใช้ทรั พยากรจากกลุ่ ม
ทรัพยากรหรือปล่อยออกของทรัพยากรจากกลุ่มที่ระบุไว้ใน Set name ช่องนี้จะปรากฎขึ้นเมื่อเลือก
ประเภทของทรัพยากรเป็นแบบกลุ่มทรัพยากรใน Selection Rule จะมีให้เลือกถึง 6กฏดังนี้ 
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  Cyclical  คือวัตถุเรียกใช้ทรัพยากรจากทรัพยากรไหนที่ว่างก่อนให้เรียกใช้ทรัพยากร
นั้นก่อน 

  Random  คือวัตถุเรียกใช้ทรัพยากรจากการสุ่มเรียกใช้ทรัพยากรจากทรัพยากรที่ว่าง 
  Perferred order คือวัตถุเรียกใช้ทรัพยากรจากล าดับทรัพยากรที่เรียงล าดับไว้ในสมาชิกของ   

Set Spreadsheet Module โดยไม่สนใจว่าทรัพยากรไหนว่างก่อน 
  Spedific member คือระบุทรัพยากรที่ต้องการเรียกใช้หรือปล่อยออก เช่น เมื่อ วัตถุดิบท า

กิจกรรมเสร็จสิ้นและวัตถุดิบต้องการปล่อยทรพยากรให้ว่างตามค่าดัชนีต่ าแหน่งล าดับของทรัพยากร
ที่ระบุใน Set index 

  Largest remaining capacity คือวัถตุดิบที่เรียกใช้ทรัพยากรที่ว่างจากทรัพยากรที่มีก าลัง
การผลิตคงเหลือมากท่ีสุดจะเรียกใช้ก่อน 

 Smallest Number Busy      คือวัตถุดิบที่เรียกใช้ทรัพยากรที่ว่างจากทรัพยากรมีจ านวนครั้งการ
ท างานน้อยสุดก่อนจะถูกเรียกใช้ก่อน 
   - Save Attribute คือการใช้คุณสมบัติ เฉพาะให้กับวัตุดิบโดย
คุณสมบัตินี้จะเก็บค่า Set index ที่แสดงต าแหน่งล าดับของทรัพยากรใน Set Spreadsheet 
Module ท าให้วัตถุดิบสามารถอ้างถึงชื่อของทรัพยากรที่ถูกเรียกใช้ หรือปล่อยออกได้ 
   - Set index   คือค่าดัชนีคุณสมบัติเฉพาะเพ่ือแสดงต าแหน่ง
ล าดับของทรัพยากรใน Set Spreadsheet Module ช่องนี้จะปรากฏเมื่อเลือกกฎในการเลือกใช้
ทรัพยากรแบบ Specific member 
   - Quantity  คือจ านวนทรัพยากรที่ จะถู ก เ รี ยก ใช้ จ าก
ทรัพยากรที่ก าหนดหรือจากกลุ่มทรัพยากร 
 
 
 ในส่วนของ Assign Module เป็นหน่วยโครงสร้างที่ใช้ส าหรับก าหนดหน้าที่ให้ตัวแปร 
(Variable) คุณสมบัติประจ าตัว (Attribute) ชนิดของวัตถุดิบ (Entity type) ภาพของวัตถุ (Entity 
Picture) หรือระบุตัวแปรอ่ืนๆ (Other) โดยการก าหนดหน้าที่สามารถ ท าได้หลายสามารถท าได้
หลายหน้าที่ในหน่วยในหน่วยโมดูลเดียวกัน ดังภาพ 2.5  
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ภาพ 2.5 แสดงหน้าต่าง Assign Module 

 
จากรูปข้อมูลที่ต้องใส่ในหน้าต่างของ Assign Module 
 - Name  คือชื่อที่ใส่ไว้ในช่องนี้ จะปรากฏเป็นชื่อบนโมดูล 
   - Assignment  คือการก าหนดหน้าที่อย่างน้อยหนึ่งอย่างให้กับวัตถุเมื่อ
วัตถุดิบเข้ามาในโมดูลนี้การก าหนดหน้าที่ท าได้โดยคลิกปุ่ม Add จะปรากฏหน้าต่างย่อย 
 
  ในส่วนของ Decide module เป็นหน่วยโครงสร้างใช้ส าหรับตัดสินใจทางเลือก
ให้กับวัตถุดิบว่าจะเป็นไปได้ในเส้นทางใดแต่ละวัตถุสามารถเลือกทางให้กับตนเองได้เพียงเส้นทาง
เดียวเท่านั้น แต่เมื่อมีเกณฑ์การตัดสินใจสองเกณฑ์ใหญ่ๆ คือใช้เกณฑ์ของโอกาสที่น่าจะเป็นไปได้ใน
การตัดสินใจ หรือใช้เงื่อนไขในการตัดสินใจ ดังภาพ 2.6  
 
จากภาพข้างต้นจะสามารถอธิบายข้อมูลที่ต้องใส่ในหน้าต่างของ Decide Module ดังนี้ 
  - Name  คือชื่อที่ใส่ไว้ในช่องนี้ จะไปปรากฏเป็นชื่อบนโมดูล 
   - Type  คือเกณฑ์ใช้ส าหรับตัดสินใจทางเลือก มีให้ เลือก 4 
ประเภท คือ 
    2-way by Chance มีทางให้เลือกโดยใช้เกณฑ์ของโอกาสที่
น่าจะเป็นไปได้ในการตัดสินใจสองทางถ้าเลือกเกณฑ์นี้ จะปรากฏ Percent True (0-100) ให้เติมค่า
โอกาสที่น่าจะเป็นจริงลงไปและโมดูลนี้จะมีสองทาง คือ จริงและเท็จ 
    N-way by condition มีทางให้ เลือกโดยใช้ เงื่อนไขในการ
ตัดสินใจสองเงื่อนไขคือ เงื่อนไขเป็นจริง กับเท็จ โดยเงื่อนไขจะถูกสร้างขึ้นด้วยตัวเลือกเหล่านี้คือ ตัว
แปร ชนิดของวัตถุและสูตร 
    N-way by chance วัตุดิบเลือกได้เพียงหนึ่งทางเลือกจาก
ทางเลือกของโอกาสที่น่าจะเป็นไปได้ N ทาง ถ้าเลือกเกณฑ์นี้การใส่ค่าโอกาสในแต่ละทางเลือก ท าได้
โดยการคลิกปุ่ม Add จะปรากฏหน้าต่างเงื่อนไข และมีช่องให้เติมค่าโอกาสที่น่าจะเป็นไปได้ใน
หน้าต่างนี้ N-1 ข้อมูล 
    N-way by condition วัตถุดิบเลือกทางเลือกได้เพียงหนึ่งทาง
จาก N ทางโดยใช้เกณฑ์ของเงื่อนไขในการตัดสินใจ ถ้าเลือกเกณฑ์นี้ การใส่ค่าเงื่อนไขให้กับทางเลือก
โดย การคลิกปุ่ม Add จะปรากฏหน้าต่างเงื่อนไขให้เติมสมการเงื่อนไขลงไป ถ้ามี N เงื่อนไขให้ใส่
เงื่อนไขในหน้าต่าง N-1 เงื่อนไข จึงจะท าให้โมดูลนี้มีทางออก N ทางเพราะอีกหนงึ่งทางคือ ทางที่จะ
ท าให้ N-1 เงื่อนไขข้างต้นเป็นเท็จ 
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  ส่วนสุดท้าย Dispose Module เป็นหน่วยโครงสร้างที่ใช้จบการท างานของวัตถุดิบ
ที่สนใจ (Entity) วัตถุจะออกจากระบบแบบจ าลองและแสดงถึงการเสร็จสิ้นของการเก็บข้อมูลพ้ืนฐาน
ทางสถิติของข้อมูลนั้น ดังภาพ 2.6 
 

 
 

ภาพ 2.6 แสดงตัวอย่าง Dispose Module 
 
 
เนื่องจากข้อมูลของทรัพยากรนั้นในการสร้างแบบจ าลองสถานการณ์จะต้องมีการก าหนดว่าทรัพยากร
ที่เราต้องการจะศึกษามีก าลังการผลิตแบบใด โดยประเภทของทรัพยากรสามารถแบ่งก าลังการผลิต
ออกเป็น การแบบผลิตแบบคงที่ หรือก าลังการผลิตแบบไม่คงที่ โดยกรณีท่ีประเภทการผลิตทรัพยากร
เป็นแบบก าลังการผลิตไม่คงที่โปรแกรมอารีน่าสามารถก าหนดตารางการท างานให้กับทรัพยากรได้ใน 
Schedule Spreadsheet Module เพราะบางครั้งทรัพยากรไม่สามารถท างานได้ตลอดเวลาโดยเรา
จะต้องมาก าหนดประเภทที่ได้กับทรัพยากรตามตัวอย่าง 

-  Name  คือชื่อทรัพยากร 
- Type   คือประ เภทของทรัพยากรมี ให้ เ ลื อก  2 ประ เภท 

ประกอบด้วยแบบมีก าลังการผลิตคงที่และแบบมีก าลังการผลิตแบบไม่คงที่ขึ้นอยู่กับตาราง
ก าหนดเวลา 

- Capacity  คือจ านวนของทรัพยากรที่มี โดยทรัพยากรทุกตัวมี
ลักษณะที่เหมือนกันจะต้องระบุจ านวนเต็มบวกและช่องนี้จะปรากฏเมื่อประเภททรัพยากรเป็นแบบ
ก าลังการผลิตคงที ่

- Schedule name  คือชื่อตารางก าหนดเวลาการท างานและช่องนี้จะปรากฏ
เมื่อเลือกประเภทของทรัพยากรแบบก าลังการผลิตไม่คงท่ีขึ้นอยู่กับตารางก าหนดเวลา 

- Schedule Rule คือการเลือกกฏการบริการเมื่อมีการเปลี่ยนแปลงก าลังการผลิต
ตามตารางก าหนดเวลาและช่องนี้ปรากฏเมื่อเลือกประเภทของทรัพยากรแบบก าลังการผลิตไม่คงที่
ขึ้นอยู่กับตารางก าหนดเวลา มีให้เลือกสามแบบคือ Ignore, Wait, Preempt โดยรูปแบบการใช้กฏ
ของการบริการต่างๆในโมดูลแสดงตารางก าหนดเวลา (Resource Spreadsheet module) 
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2.3 การประมวลผลโปรแกรม 
 
การประมวลผลโปรแกรมอารีน่า (Arena) สามารถท าได้โดยเลือกแถบเครื่องมือ Run > setup เลือก
แถบเครื่องมือ Replication Parameter จะปรากฏหน้าต่างดังภาพ 2.7 เพ่ือให้ผู้ใช้ก าหนดขอบเขต
การประมวลผลโดยป้อนข้อมูลที่ใช้ในการประเมินลงในช่องรับข้อมูล ก าหนดรูปแบบการประมวลชนิด
ที่เป็นระบบที่มีการสิ้นสุด (Termination System) ซึ่งเป็นระบบที่มีการสิ้นสุดการประมวลผลที่
แน่นอนด้วยเงื่อนไขที่ก าหนด ซึ่ งสามารถประมวลผลซ้ าได้มากกว่าหนึ่ งครั้ ง  (Number of 
Replication) 
 

 
 

ภาพ 2.7 แสดงตัวอย่าง Replication Parameters 
2.4 การวิเคราะห์ข้อมูลรับเข้า 
  
 การสร้างตัวแบบจ าลองสถานการณ์จ าเป็นต้องมีการน าเข้าข้อมูลรับเข้าใส่ให้กับระบบจ าลอง
สถานการณ์เพ่ือใช้ในการวิเคราะห์ระบบ เช่น ระยะเวลาในการท างานของเครื่องจักร ซึ่งข้อมูลเหล่านี้ 
เป็นข้อมูลที่มีค่าไม่แน่นอนและเป็นข้อมูลที่อยู่ในรูปของการแจกแจง ดันั้นการวิเคราะห์ข้อมูลรับเข้า
จึงมีความส าคัญแบบจ าลองสถานการณ์เป็ฯอย่างมากเพราะถ้าผ็วิเคราะห์ใส่รูปแบบการแจกแจงไม่
ถูกต้องให้กับระบบ ผลลัพธ์จพท าให้ผลลัพธ์ที่ได้จากแบบจ าลองสถานการณ์ไม่ถูกต้องตามไปด้วย  
 Input Analyzer เป็นเครื่องมือมาตรฐานของโปรแกรมอารีน่า เครื่องมือนี้จะใช้เพ่ือทดสอบ
ค่าการกระจายของข้อมูลที่ป้อนเข้าไปว่ามีค่าการกระจายตัวแบบใดและเครื่องมือนี้ยังมีความสามารถ
สร้างกลุ่มข้อมูลแบบสุ่มให้มีลักษณะการกระจายตัวตามที่ต้องการได้ โดยสามารรถเรียกใช้งาน ได้ 2 
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ช่องทางคือเมนู Start > Program Files > Rockwell software > Arena > Input analyzer หรือ
เมื่อเข้าสู่ โปรแกรมอารีน่าให้เจ้าไปที่ เมนู  Tools > Input analyzer ขั้นตอนในการใช้ Input 
Analyzer ขั้นตอนแรกคือต้องเก็บรวบรวมข้อมูลที่ต้องการจะศึกษา จากนั้นให้น าข้อมูลที่ได้ป้อนเข้ า
ไปในไฟล์ Excel หรือ Notepad แล้วท าการบันทึกให้เป็นนามสกุลของไฟล์ใหม่เป็น “ชื่อไฟล์.txt” 
หรือ “ชื่อไฟล์.dst”  
 หลังจากนั้นจะต้องการ input ข้อมูลด้วยเมนู File > Data File > Use Existing เลือกไฟล์ที่
ต้องการจะทดสอบค่าการกระจายแล้วท าการเลือกค าสั่ง Fit > Fit All จะปรากฎหน้าต่างแสดง
รูปแบบการกระจายตัวของข้อมูลและสามารถท าการตรวจสอบว่าการกระจายตัวนั้นเหมาะสมหรือไม่ 
โดยการตรวจสอบค่า P-value ว่ามีค่ามากกว่าระดับนัยส าคัญ (significance level) หรือไม่จากการ
ตั้งสมมุติฐานที่ว่า 
   𝐻0 : ข้อมูลมีการกระจายตัวตามแบบท่ีต้องการทดสอบ 
  𝐻1 : ข้อมูลไม่มีการกระจายตัวตามแบบท่ีต้องการทดสอบ 
 โดยโปรแกรมอารีนา (Arena) มีวิธีการทดสอบสมมุติฐานการกระจายตัวของความน่าจะเป็น
ของข้อมูล (Goodness of fit test) มี 2 วิธีด้วยกันดังนี้ 
 - วิธีการทดสอบโคโมกรอฟ-สเม็นร์นอฟ (Komogorov-Smirnov Test) ฬช้ทดสอบในกรณี
ที่มีข้อมูลน้อยกว่า 50 ข้อมูล 
 - วิธีการทดสอบไชสแควร์ (Chi Square Test) ใช้ทดสอบในกรณีข้อมูลอย่างน้อย 50 ข้อมูล
โดยทั้งสองวิธีนี้ โปรแกรมอารีนาจะค านวณค่า P-value ที่ได้จากการทดลองสมมุติฐาน ถ้าค่า P-
value ที่ได้จากการทดสอบมากกว่าระดับนัยส าคัญจะยอมรับสมมุติฐานหลัก ( 𝐻0) มิฉะนั้นจะ
ปฏิเสธสมมุติฐานหลัก (𝐻0) ดั้งนั้นจะต้องตั้งสมมุติฐานและตรวจสอบค่า P-Value ทุกครั้งก่อนน า
การกระจายตัวที่ได้ไปเป็นตัวเองแทนข้อมูล เพ่ือใช้เป็นตัวแทนของข้อมูลน าเข้าให้กับแบบจ าลอง
สถานการณ์ต่อไป ตัวอย่างรูปแบบการกระจายตัวของข้อมูล ดังภาพ 2.8 
 

 
 

ภาพ 2.8 แสดงตัวอย่างการกระจายตัวของข้อมูล 
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2.5 การวิเคราะห์กระบวนการน าออก 
 
 การวิเคราะห์กระบวนการน าออก (Process Analyzer) เป็นเครื่องมือมาตรฐานของ
โปรแกรมอารีนาเครื่องมือนี้ช่วยในการสร้างทางเลือกให้กับระบบ เพ่ือเปรียบเทียบผลลัพธ์ของระบบ
ดั้งเดิมกับผลลัพธ์ของระบบทางเลือกว่า ค าตอบไหนดีกว่ากัน โดยไม่ต้องสร้างแบบจ าลองสถานการณ์
ใหม่ ท าให้ง่ายในการตัดสินใจเลือกทางที่เหมาะสมที่สุดให้กับตัวแบบเครื่องมือ Process Analyzer นี้
ใช้ได้ก็ต่อเมื่อแบบจ าลองสถานการณ์ของระบบดั้งเดิมได้ผ่านการรันเสร็จสิ้นแล้ว ซึ่งจะปรากฏ
ไฟล์ข้อมูลคือ “ชื่อไฟล์.p” โดยขั้นตอนการใช้งานเครื่องมือ Process Analyzer มีดังนี้ 
 1. เรียกใช้เครื่องมือ Process analyzer 
 2. ในหน้าต่าง Process analyzer เลือกเข้าเมนู File > New จะปรากฏหน้าต่างดังภาพ 
2.12 
 3. เข้าเมนู Insert > Scenario หรือดับเบิ้ลคลิกในต าแหน่ง Double click here to add a 
new Scnenario เพ่ือเพ่ิมแผนการด าเนินงานเข้ามา จะปรากฎหน้าต่างเพื่อให้ใส่ข้อมูล 
 จากนั้นให้เขียนชื่อแผนการด าเนินงานที่ต้องการในช่อง Name และคลิกปุ่ม Browes เพ่ือ
เลือกแบบจ าลองที่ต้องการโดยแบบจ าลองที่ เลือกจะต้องเป็นไฟล์นามสกุล p เท่านั้นเมื่อเลือก
แบบจ าลองที่ต้องการได้แล้วให้คลิกปุ่ม OK จะปรากฏหน้าต่าง  
 
 4. เลือกเมนู Insert > Control เพ่ือเลือกตัวแปรควบคุมที่ต้องการเปลี่ยนค่า โดยผ็ใช้
โปรแกรมสามารถเลือกตัวแปรควบคุมได้มากกว่าหนึ่งตัว โดยการเข้าเมนู Insert > Control ซ้ าอีก
ครั้งหนึ่ง 
 5.เข้าไปเมนู Insert > Response เพ่ือเลือกผลตอบสนองที่ต้องการเปรียบเทียบกับผลลัพธ์
กับแผนการด าเนินงานอ่ืน ผู้ใช้สามารถเลือกผลตอบสนองได้มากกว่าหนึ่งตัว โดยการเข้าไปที่เมนู 
Insert > Response อีกครั้งหนึ่ง ซึ่งแสดงตัวอย่างไว้ในภาพ 2.16 
 6.ท าซ้ าตั้งแต่ขั้นตอนที่ 3 ถึงข้ันตอนที่ 5 ใหม่เพ่ือสร้างแผนด าเนินงานที่จะน ามาเปรียบเทียบ
ขึ้นมาซ่ึงสามารถสร้างได้มากกว่าหนึ่งแผนการด าเนินงาน 
 7. ปรับเปลี่ยนค่าตัวควบคุมท่ีต้องการได้ในช่อง control ดังภาพ 2.17 
 8. ท าการ Run แผนการด าเนินงานโดยคลิกไฮไลท์แผนการด าเนินงานที่ต้องการรันจากนั้น
เข้าไปที่เมนู Run > Go จะปรากฎหน้าต่างดังภาพ 2.18 จากนั้นคลิกปุ่ม OK 
 9. ดูผลลัพธ์การรันในช่อง Response เพ่ือเปรียบเทียบผลลัพธ์ของการด าเนินงานแต่ละแผน 
 
2.6 เทคนิคการศึกษางาน 
 



 
 

16 

โครงงานวิจัยของ พีระวิทย์ วันทอง (2559) เรื่อง การวิเคราะห์และปรับปรุงกระบวนการ
ผลิตของผลิตภัณฑ์เครื่องประดับ ด้วยการจ าลองคอมพิวเตอร์ โดยมีวัตถุประสงค์ เพ่ือปรับปรุง
สายการผลิตในส่วน Pre-plate ของกลุ่มผลิตภัณฑ์สร้อยคอโดยใช้เทคนิค ECRS, line balancing 
การศึกษางานเพ่ือเพ่ิมประสิทธิภาพของการสายการผลิต และแสดงผลด้วย การจ าลองสถานการณ์
ด้วยคอมพิวเตอร์โครงงานวิจัยของ อรจิตร แจ่มแสง และประสาน แสงเขียว (2559) วิจัยนี้มี
วัตถุประสงค์ ศึกษาวิธีการท างานและจับเวลากระบวนการผลิตของผลิตภัณฑ์บรรจุสับปะรดกระป๋อง 
ออกแบบและจ าลองสถานการณ์ (Simulation) จากการด าเนินงานตามแผนที่วางไว้แล้วนั้นซึ่งได้ท า
การสร้างแบบจ าลองกระบวนการผลิต ในการสร้างแบบจ าลองครั้งนี้ได้เลือกใช้โปนแกรม Arena มา
ใช้ในการจ าลองแบบปัญหาซึ่งโปรแกรมอารีน่าเป็นแบบจ าลองสถานการณ์ซึ่งสามารถจ าลอง
สถานการณ์ได้ใกล้เคียงกับระบบงานจริง และยังสามารถน าไปประยุกต์ใช้กับระบบงานหลายประเภท 
รวมทั้งเป็นโปรแกรมที่มีความซับซ้อนไม่มากนักสามารถเข้าใจได้ง่ายสะดวกต่อการใช้งานมีการแสดง
ภาพเคลื่อนไหว (Animation) ท าให้จ าลองสถานการณ์เข้าใจได้มากขึ้น 
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บทท่ี 3 

 

ระเบียบวิธีท าโครงงาน 

 

 

ในการศึกษากระบวนการผลิตผลไม้อบแห้ง ผู้วิ จัยเล็งเห็นว่าสามารถใช้แบบจ าลอง
สถานการณ์ มาประยุกต์ใช้ในการจัดตารางการอบผลไม้ เนื่องจากปัจจุบันทางวิสาหกิจชุมชนบ้านล่าง
ช้างสามารถผลิตผลไม้อบไม้เพียงหนึ่งชนิดต่อหนึ่งรอบกระบวนการผลิต ทางผู้วิจัยจึงได้ท าการเก็บ
ข้อมูลและน ามาสร้างแบบจ าลองเพ่ือจ าลองกระบวนการผลิตที่ สามารถผลิตผลไม้อบแห้งตั้งแต่สอง
ชนิดขึ้นไปในหนึ่งกระบวนการผลิตได้ ซึ่งมีข้ันตอนดังภาพ 3.1  

 

 

 

 

 

 

 

 

 

 

 
ภาพ 3.1 ขั้นตอนการด าเนินการวิจัย 

 

3.1 ศึกษากระบวนการผลิตผลไมอ้บแห้งของวิสาหกิจชุมชน 

3.2 เก็บข้อมูลโดยจากจับเวลาทุกกระบวนการย่อยในกระบวนการผลิตมะม่วงอบแห้ง 

3.3 เก็บข้อมูลโดยจากจับเวลาทุกกระบวนการย่อยในกระบวนการผลิตมะม่วงล าใย 

3.4 น าข้อมูลเวลามาวิเคราะห์เพื่อน ามาสร้างแบบจ าลองโดยใช้โปรแกรมจ าลองสถานการณ์ 

3.5 ท าการทดลองจัดรูปแบบของโปรแกรมจ าลองการณ์เพื่อสร้างแบบจ าลองการผลติผลไม้
อบแห้งสองชนิด 

3.6 ท าการสรุปการทดลอง และจดัท ารายงานน าเสนอ 
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3.1 ศึกษากระบวนการผลิตผลไม้อบแห้งของวิสาหกิจชุมชนบ้านล่ามช้าง 

 3.1.1 กระบวนการผลิตมะม่วงอบแห้ง 

กระบวนการผลิตมะม่วงอบแห้งแบ่งออกเป็น 5 ขั้นตอนดังภาพ ภาพ 3.2 
 
 
 
 
 
 
 
 
 
 
 
 

 
ภาพ 3.2 กระบวนการผลิตมะม่วงอบแห้ง 

 
1. น ามะม่วงสุกมาไว้ที่ห้องเก็บวัตถุดิบ 
2. น ามะม่วงสุกมาปลอกเปลือกท้ังลูก 
3. น ามะม่วงสุกที่ท าการปลอกเปลือกแล้วไปให้ส่วนที่ท าการหั่น โดยท าการหั่นมะม่วงเป็นชิ้น

ยาวประมาณ 16 เซนติเมตร หนาประมาณ 8 มิลลิเมตร แล้วท าการจัดเรียงบนถาด ดังภาพ  
4. น าถาดที่จัดเรียงมะม่วงเสร็จแล้วไปไว้ที่รถเข็นส าหรับเข้าตู้อบ เรียงเป็นชั้นจนเต็มจ านวน 

9 ชั้น 
5. น ามะม่วงในรถเข็นเข้าตู้อบ ใช้เวลาในการอบประมาณ 7 ชั่วโมง ที่อุณหภูมิ 60-70 องศา

เซลเซียส และท าการตรวจเช็คว่าได้ระดับความชื้นที่พอใจหรือไม่ 
6.น ามะม่วงที่อบเสร็จแล้วและได้ระดับความชื้นที่ต้องการ มาแบ่งใส่ถุงพลาสติก ถุงละ 5 

กิโลกรัมทียังอบไม่ได้ระดับความชื้นที่ต้องการ จะน ากลับไปอบอีกครั้งหนึ่ง 
7. ปล่อยมะม่วงอบที่แบ่งใส่ถุงทิ้งไว้เป็นเวลาอย่างน้อย 3 วัน 
8. จากนั้นน ามะม่วงอบแห้งมาแบ่งใส่ถุงซิปล็อค และติดฉลากผลิตภัณฑ์ 

 
 
 
 
 

รับวัตถุดิบ(มะม่วง) ปอกเปลือก/ผ่าให้เป็นสี่
ช้ินย่อย 

จัดเรยีงใส่ถาดอบ 

น าเข้าตู้อบและอบท่ี
อุณหภูมิ 70-60องศา

เซลเซียส 

น าผลไม้ที่อบเสร็จมา
วัดความชื้น 

น ามะม่วงมาใส่บรรจุ
ภัณฑ์แล้วพักไวส้ามวัน 

มะม่วงที่ไมผ่่านการ
ตรวจวัดความชื้น 

ติดฉลากผลิตภณัฑ ์

และจัดจ าหน่าย 
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3.1.2 ศึกษากระบวนการผลิตล าไยอบแห้ง 
 
ศึกษากระบวนการผลิตล าไยอบแห้งแบ่งออกเป็น 5 ขั้นตอนดังภาพ 3.3 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
ภาพ 3.3 กระบวนการผลิตล าไยอบแห้ง 
 
1. น าล าไยสุกมาไว้ที่ห้องเก็บวัตถุดิบ 
2. น าล าไยสุกมาปลอกเปลือกท้ังลูกและคว้านเมล็ดออกจากนั้นจึงล้างผลล าไย 
3. น าถาดที่จัดเรียงล าไยเสร็จแล้วไปไว้ที่รถเข็นส าหรับเข้าตู้อบ เรียงเป็นชั้นจนเต็ม จ านวน 9 

ชั้น 
0. น าล าไยในรถเข็นเข้าตู้อบ ใช้เวลาในการอบประมาณ 0 ชั่ วโมง อบที่อุณหภูมิ 06-05 

องศสเซลเซียส และท าการตรวจเช็คว่าได้ระดับความชื้อที่พอใจหรือยัง 
5. น าล าไยที่อบเสร็จแล้วและได้ระดับความชื้นที่ต้องการ มาแบ่งใส่ถาดและน าไปตากแดด 

16-12 ชั่วโมง ส่วนล าไยที่ยังอบไม่ได้ระดับความชื้นที่ต้องการ จะน ากลับไปอบอีกครั้งหนึ่ง 

0. น าล าไยอบแห้งมาแบ่งใส่ถุงซิปล็อคและติดฉลากผลิตภัณฑ์ 

 

 

 

 

 

รับวัตถุดิบ(ล าไย) ปอกเปลือก/คว้าน
เมลด็/ล้างผลล าไย 

จัดเรยีงใส่ถาดอบ 

น าเข้าตู้อบและอบท่ี
อุณหภูมิ 65-60องศา

เซลเซียส 

น าผลไม้ที่อบเสร็จมา
วัดความชื้น 

น าล าไยมาตากแดด 10-

12 ช่ัวโมง 

ล าไยทีไ่มผ่่านการ
ตรวจวัดความชื้น 

ติดฉลากผลิตภณัฑ ์

และจัดจ าหน่าย 
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3.1.3 ศึกษากระบวนการผลิตมะเขือเทศอบแห้ง 
ศึกษากระบวนการผลิตมะเขือเทศอบแห้งแบ่งออกเป็น 6 ขั้นตอนดังภาพ 3.4 

ภาพ 3.4 กระบวนการผลิตมะเขือเทศอบแห้ง 
 
1. น ามะเขือเทศมาไว้ที่ห้องเก็บวัตถุดิบ 
2. น ามะเขือเทศที่ได้มาเข้าเครื่องเจาะเมล็ด 
3. น ามะเขือเทศที่ได้รับการเจาะเมล็ดออกไปแล้วมาใส่ถุงที่มีน้ ายาปูนใสถุงละ 5 กิโลกรัมแช่

ค้างไว้1คืน 
0. น าถุงมะเขือเทศท่ีได้รับการแช่น้ าปูนใสไว้แล้วหนึ่งคืนมาแกะถุงแล้วน าไปต้มในกระทะที่มี

ระดับน้ าเดือด 100 องศาเซลเซียส เป็นเวลา 5 นาที 
5. น ามะเขือเทศที่ได้รับการต้มมาพักชั่วขณะจากนั้นจึงน าไปเข้าตู้อบที่อุณหภูมิ 70 องศา

เซลเซียสเป็นเวลาประมาณ 12 ชั่วโมง 

0. น ามะเขือเทศอบแห้งมาแบ่งใส่กล่องพลาสติกและติดฉลากผลิตภัณฑ์ 

 

3.2 รวบรวมข้อมูลเวลาในกระบวนการผลิตผลไม้อบแห้งและน ามาวิเคราะห์การกระจายตัวทาง
สถิติ โดยใช้ โปรแกรม อินพุต อนาไลเซอร์ (Input Analyzer) 

 หลังจากท าการเก็บข้อมูลเวลาต่างๆในทุกกระบวนการผลิตผลไม้อบแห้ง  3 ชนิด ได้แก่ 
มะม่วงอบแห้ง, ล าใยอบแห้ง, มะเขือเทศอบแห้งนั้น ขั้นตอนต่อไปคือการน าข้อมูลเวลาที่รวบรวม
ได้มาวิเคราะห์การกระจายตัวทางสถิติ โดยใช้โปรแกรม Input analyzer ในการท าการวิเคราะห์ หาก
ค่าความเชื่อมั่นทางสถิติ (P-value) ของข้อมูลเวลาดังกล่าวมีค่าเกิน 0.05 หรือร้อยละ 95 จะแสดงให้
เห็นว่าข้อมูลนั้นมีความน่าเชื่อถือและสามารถน าค่าการกระจายตัวทางสถิติ (P-value) ของข้อมูล
เวลาดังกล่าวมีค่าต่ ากว่า 0.05 หรือร้อยละ 95 แสดงว่าข้อมูลยังไม่มีความเชื่อถือที่มากพอ ผู้ศึกษา
ต้องท าการเก็บข้อมูลในกระบวนการนั้นๆเพ่ิมขึ้น โดยการวิเคราะห์ข้อมูลในโปรแกรม Input 
analyzer สามารถแบ่งออกได้เป็น 2 วิธีด้วยกันคือ 

 1. วิธีการทดสอบ Komogorov-Simrnov Test ใช้ทดสอบกรณีข้อมูลมีจ านวนน้อยกว่า 50 
ข้อมูล 

 2. วิธีทดสอบ Chi-square Test ใช้ทดสอบในกรณีท่ีข้อมูลเวลามีจ านวนอย่างน้อย 50 ข้อมูล
ขึ้นไป 
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3.3 สร้างแบบจ าลองสถานการณ์โดยใช้โปรแกรมอารีนา (Arena) 

 สร้างแบบจ าลองสถานการณ์ของกระบวนการผลิตของผลไม้อบแห้งทั้งสามชนิดและแบบ
หลากชนิดพร้อมกันในหนึ่งกระบวนการผลิตซึ่งแบบจ าลองสถานการณ์จะถูกสร้างจากข้อมูลการ
ท างานที่ผู้ศึกษาได้เก็บรวบรวมในขั้นตอนต้น โดยแบบจ าลองสถานการณ์ต้องมีความใกล้เคียงกับ
สถานการณ์จริงมากท่ีสุดเพ่ือการนั้นผู้สร้างจึงต้องเก็บข้อมูลจากการท างานจริงด้วยตนเอง โดยต้องให้
ข้อมูลกระบวนการผลิตและข้อมูลการกระจายตัวทางสถิติของเวลาที่น ามาใช้ในโปรแกรมจ าลอง
สถานการณ์ยังต้องมีความแม่นย ามากที่สุดเพ่ือที่จะท าให้แบบจ าลองสถานการณ์เกิดความ
คลาดเคลื่อนน้อยที่สุด หลังจากก าหนดสร้างแบบจ าลองสถานการณ์แล้วจะท าการตรวจสอบความ
ถูกต้องในแง่ของการท างานโดยการเปรียบเทียบการไหลของวัตุดิบที่ไหลในระบบในแบบจ าลองกับ
การไหลของกระบวนการจริงจากการเก็บข้อมูลว่ามีการท างานที่เหมือนกันหรือไม่ จากนั้นจะท าการ 
Run แบบจ าลองเพ่ือตรวจสอบความถูกต้องโดยการน าเอาผลลัพธ์จากการทดลองไปเปรียบเทียบกับ
ค่าที่เกิดขึ้นจริงในระบบจริง โดยตัวชี้วัดที่จะน ามาเปรียบเทียบทางสถิติ ที่ระดับนัยส าคัญ 0.05 เพ่ือ
ยืนยันว่าแบบจ าลองที่สร้างขึ้นนั้นจะสามารถใช้แทนกระบวนการผลิตจริงได้ 

 

3.4 วิเคราะห์ปัญหาจากแบบจ าลองสถานการณ์และน าเสนอแนวทางการจัดตารางตู้อบ 

 น าแบบจ าลองสถานการณ์ที่สร้างขึ้นมาท าการวิเคราะห์เพ่ือหาแบบจ าลองที่ดีที่สุดในการใช้
ตู้อบผลไม้อบแห้งเพ่ือน ามาเป็นแนวทางให้การจัดตารางตู้อบกระบวนการผลิตที่สามารถผลิตผลไม้
หลากชนิดในหนึ่งกระบวนการผลิต 

 

3.5 สรุปผลการด าเนินงาน จัดท ารายงานโครงงานวิจัยและการาน าเสนอ 

 สรุปผลโดยการเลือกแนวทางงการจัดตารางตู้อบที่ดีที่สุดที่ได้จากการท าแบบจ าลองแบบผลิต
ทีละ 1ชนิด 2 ชนิด, 3ชนิด พร้อมกัน น าทุกแบบจ าลองมาเปรียบเทียบกันโดยใช้เกณฑ์การ
เปรียบเทียบค่า P-Value ที่ดีที่สุด จากนั้นท าการรวบรวมเอกสารและข้อมูลที่เกี่ยวข้องทั้งหมดที่ใช้ใน
การท าโครงงานวิจับและจัดท าเป็นรูปเล่ม 
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บทท่ี 4 

 

ผลการด าเนินการของโครงการวิจัย 

 

 

4.1 ศึกษาและเก็บข้อมูลขั้นตอนและเวลาการท างานในแต่ละขั้นตอนของผลิตภัณฑ์ 

 จากการได้ท าการศึกษาท่ี วิสาหกิจชุมชนแปรรูปผลิตภัณฑ์เกษตรบ้านล่ามช้าง มีลักษณะของ
กระบวนการผลิตเป็นแบบท าตามความต้องการของลูกค้า (Make to order) โดยที่ผ่านมาได้ศึกษา
และเก็บข้อมูลกระบวนการผลิตของวิสาหกิจ ได้ข้อมูลของกระบวนการผลิตมะม่วงอบแห้ง ล าไย
อบแห้ง และมะเขือเทศอบแห้ง โดยกระบวนการทั้งสามอย่างนั้นมีกระบวนการผลิตที่แตกต่างกัน  
ขั้นตอนการผลิตของวัตถุดิบและรายละเอียดการสร้างแบบจ าลองสถานการณ์ จะแสดงในตารางที่ 4.1 

ตาราง 4.1 รายละเอียดกระบวนการผลิตของผลิตภัณฑ์มะม่วงอบแห้ง  

กระบวนการ
ผลิต 

จ านวน
เครื่องจักร 

จ านวนคนงาน รายละเอียดการท างาน 

ปอกเปลือก - 0 น ามะม่วงสุกมาปอกเปลือกออกท้ังหมด
โดยใช้มีดเป็นอุปกรณ์ในการปลอกเปลือก 

หั่นเป็นชิ้น - 2 น ามะม่วงสุกท่ีปอกเปลือกแล้วมาท าการ
หั่นเป็นชิ้นยาวประมาณ 8 เซนติเมตร 
หนาประมาณ 8-10 เซนติเมตร 

จัดเรียงใส่
ถาด 

- 2 น ามะม่วงที่หั่นเป็นชิ้นจัดเรียงบนถาด
อย่างเป็นระเบียบวางห่างกันประมาณ 1 
เซนติเมตร จนเต็มถาดแล้วน าใส่รถเข็น
เพ่ือน าเข้าตู้อบต่อไป โดยหนึ่งรถเข็นจะมี
ถาดท้ังหมดจ านวน 9 ถาด 

การอบ 8 1 
 
 
 
 

น ารถเข็นที่จัดเรียงมะม่วงจนเต็มเข้าตู้อบ 
โดยตู้อบจะมีจ านวนทั้งหมด8ตู้ ใช้เวลาใน
การอบมะม่วงประมาณ 17 ชั่วโมง ที่
อุณหภูมิ 06-76 องศาเซลเซียล 
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ตาราง 4.1 รายละเอียดกระบวนการผลิตของผลิตภัณฑ์มะม่วงอบแห้ง (ต่อ) 

การคัดแยก - 2 น ามะม่วงที่อบเสร็จแล้วมาท าการแบ่งใส่
ถุง ถุงละ 5 กิโลกรัม จากนั้นมัดปิดปากถุง
และปล่อยทั้งไว้เป็นเวลา 3 วัน เพ่ือให้
มะม่วงอบคลายตัว 

การบรรจุ
และติดฉลาก
ผลิตภัณฑ์ 

- 1 น ามะม่วงอบแห้งที่ท าการปล่อยทิ้งไว้ครบ
ก าหนดเวลา มาจัดใส่บรรจุภัณฑ์ถุงละ 
566 กรัม แล้วท าการปิดปากถุงด้วยเครื่อง
ซีลปิดปากถุ ง จากนั้นน า ไปติดฉลาก
ผลิตภัณฑ์ 

 

การกระจายตัวทางสถิติของข้อมูลในแต่ละกระบวนการ 

 หลังจากศึกษาขั้นตอนการผลิตผลิตภัณฑ์มะม่วงอบแห้งและได้ท าการบักทึกเวลาของ
กระบวนการซึ่งจะแสดงในภาคผนวก จากนั้นน าข้อมูลเวลาของกระบวนการมาวิเคราะห์การกระจาย
ตัวทางสถิติของข้อมูลเวลาของแต่ละกระบวนการ โดยใช้เครื่องมือ Input Analyzer โดยข้อมูลการ
กระจายตัวทางสถิติของข้อมูลเวลาและวิธีการวิเคราะห์จะแสดงดังตาราง 4.2 

ตาราง 4.2 แสดงค่า P-value และ การกระจายตัวทางสถิติ 

กระบวนการผลิต P-Value การกระจายตัวทางสถิติ 
ปอกเปลือก 0.139 7.68 + 1.08 * BETA(2.05, 2.02) 

หั่น / จัดเรียงใส่ถาด 0.005 NORM(734, 15.3) 

การคัดแยก 0.15 524 + 86 * BETA(0.707, 0.753) 

การบรรจุและติดฉลาก
ผลิตภัณฑ์ 

0.15 75 + LOGN(3.03, 3.5) 

 

4.2สร้างแบบจ าลองสถานการณ์โดยใช้ข้อมูลจากโปรแกรมอารีน่า (Arena) 

 ขั้นตอนต่อไปคือการเขียนแบบจ าลองสถานการณ์แบบเรียงตามล าดับการท างานด้วย
โปรแกรมอารีนา (Arena) จากนั้นจึงบันทึกข้อมูลการกระจายตัวทางสถิติของเวลาลงในแบบจ าลอง
สถานการณ์ที่สร้างขึ้นมา โดยแบบจ าลองสถานการณ์ที่ใช้แทนการท างานของการผลิตมะม่วงอบแห้ง
สามารถแสดงได้ดังภาพ 4.1 
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ภาพ 4.1 แบบจ าลองสถานการณ์มะม่วงอบแห้ง 

โดยสามารถอธิบายความสัมพันธ์และการท างานของแบบจ าลองสถานการณ์ โดยน าแบบจ าลอง
สถานการณ์มาขยาย ซึ่งอธิบายได้ดังนี้ 

 

  

ภาพ 4.2 แสดงโมดูล Create Mango 

 

รายละเอียดข้อมูลที่ใส่ในโมดูล Create Mango ข้อมูลที่จะท าการใส่ในโมดูลนี้คือข้อมูลการกระจาย
ตัวทางสถติิของการมาถึงของมะม่วง ดังภาพ 4.2 
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ภาพ 4.3 แสดงโมดูล Process cutting skin 

 

 ข้อมูลที่ใส่ในกระบวนการปอกเปลือกมะม่วง โดยขั้นตอนนี้จะใช้ทรัพยากรคือ พนักงานปอก
เปลือก (workercutting) จ านวน 4 คน โดยใช้การกระจายตัวทางสถิติของเวลาการปอกเปลือก
มะม่วงแบบ 166*(7.68+1.08*BETA(2.05,2.02)) ดังภาพ 4.3 

 

 

 

 

 

 

 

 

 

 

ภาพ 4.4 แสดงโมดูล Process Array 
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ภาพ 4.4 แสดงข้อมูลที่ใส่ในกระบวนการหั่นและจัดเรียงบนถาด โดยขั้นตอนนี้จะใช้
ทรัพยากรคือ พนักงานหั่นมะม่วงและจัดเรียงบนถาด (worker) จ านวน 2 คน โดยมีการกระจายตัว
ทางสถิติของเวลาการหั่นและจัดเรียงมะม่วงบนถาดเป็นแบบ (NORM(730,15.3))*2.222 

 

ภาพ 4.5 โมดูล Batch to car 

จากภาพ 4.5 แสดงโมดูล Batch to car โดยโมดูลนี้มีหน้าที่รวบรวมวัตถุดิบมะม่วงที่จัดเรียง
บนถาดแล้วเพ่ือแยกออกเป็น Lot โดยจะรวมวัตถุดิบครั้งละ 56 กิโลกรัม เพื่อน าเข้าสู่กระบวนการอบ
ต่อไป 
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ภาพ 4.6 แสดงโมดูล Process heating 

 ภาพ 4.6 แสดงข้อมูลที่ใส่ในกระบวนการอบมะม่วง ทรัพยากรโมดูลนี้ประกอบไปด้วย Set 
ของตู้อบ (Set machine)  

 

 

ภาพ 4.7 แสดงโมดูล Separate 1 

  

ภาพ 4.7 แสดงรายละเอียดที่ป้อนในโมดูล Separate 1 โมดูลนี้ใช้เพ่ือแยกมะม่วงออกอบ
ออกจากรถเข็น หลังจากกระบวนการอบ 

 

  

ภาพ 4.8 แสดงโมดูล Process pick up 
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 ภาพ 4.8 แสดงรายละเอียดที่ป้อนในโมดูล Process pick up โมดูลนี้ใช้เพ่ือคัดแยกมะม่วง
อบแห้งใส่ถุง โดยบรรจุถุงละ 5 กิโลกรัม โดยขั้นตอนนี้จะใช้ทรัพยากรคือ พนักงานคัดแยก 
(Resource WK pk) จ านวน 1 คน โดยมีเวลาที่ใช้ในกระบวนการเป็นการกระจายตัวแบบ (520+80*
BETA(6.767,6.753))*2 

 

 

  

ภาพ 4.9 แสดงโมดูล Process packing 

 

 ภาพ 4.9 แสดงรายละเอียดโมดูล Process packing โดยโมดูลนี้ใช้เพ่ือแสดงกระบวนการ
บรรจุและติดฉลากมะม่วงอบแห้ง บรรจุใส่ถุงละ 500 กรัม โดยโมดูลนี้ใช้ทรัพยากรคือพนักงานบรรจุ
และติดฉลาก (WK packing) จ านวน 1 คน โดยมีเวลาที่ใช้ในกระบวนการมีการกระจายตัวทางสถิติ
แบบ (75+LOGN(3.63,3.5))*166 

 

 

 

 

 

ภาพ 4.10 แสดงโมดูล Dispose 1 
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 ภาพ 4.10 แสดงรายละเอียดของโมดูล Dispose 1 โมดูลใช้เพ่ือแสดงการสิ้นสุดของ
กระบวนการผลิตในแบบจ าลองสถานการณ์ 

ตาราง 4.3 รายละเอียดกระบวนการผลิตของผลิตภัณฑ์ล าไยอบแห้ง  

กระบวนการ
ผลิต 

จ านาวน
เครื่องจักร 

จ านวนคนงาน รายละเอียดการท างาน 

ปอกเปลือก/
คว้านเมล็ด 

- 0 น าล าไยสุกมาปลอกเปลือกทั้งลูกและ
คว้านเมล็ดออกจากนั้นจึงล้างผลล าไย 

จัดเรียงใส่
ถาด 

- 2 เทล าไยลงบนถาดส าหรับน าเข้าตู้อบ และ
จัดเรียงถาดล าไยในถาดให้เต็ม เป็ฯ

ระเบียบไม่ทับซ้อนกัน เรียงใส่รถเข็นให้
ครบ 9 ถาด 

การอบ 8 1 น ารถเข็นที่จัดเรียงล าไยบนถาดเข้าตู้อบ 
โดยตู้อบจะมีจ านวนทั้งหมด 8 ตู้ ใช้เวลา
ในการอบ 12 ชั่วโมง ที่อุณหภูมิในการอบ 

06-76 องศาเซลเซียล 
แบ่งใส่ถาด - 1 น าล าไยที่ท าการอบเสร็จแล้วน ามาแบ่งใส่

ถาดและคัดล าไยที่ไม่ได้มารตฐานออก 
ตากแห้ง - 1 น าล าไยอบแห้งที่แบ่งใส่ถาดมาตากไว้ 16 

ชั่วโมง 
การบรรจุ

และติดฉลาก
ผลิตภัณฑ์ 

- 1 น าล าไยอบแห้งที่ตากแล้ว มาบรรจุลงถุง 
566 กรัม พร้อมซีลปิดปากถุงและติดฉลาก

ผลิตภัณฑ์ 
 

 หลังจากศึกษาขั้นตอนการผลิตผลิตภัณฑ์มะม่วงอบแห้งและได้ท าการบักทึกเวลาของ
กระบวนการซึ่งจะแสดงในภาคผนวก จากนั้นน าข้อมูลเวลาของกระบวนการมาวิเคราะห์การกระจาย
ตัวทางสถิติของข้อมูลเวลาของแต่ละกระบวนการ โดยใช้เครื่องมือ Input Analyzer โดยข้อมูลการ
กระจายตัวทางสถิติของข้อมูลเวลาและวิธีการวิเคราะห์จะแสดงดังตาราง 4.4 

ตาราง 4.4 การกระจายตัวทางสถิติของล าใยอบแห้ง 

กระบวนการผลิต P-Value การกระจายตัวทางสถิติ 
ปอกเปลือก/คว้านเมล็ด 0.75 TRIA(2.78, 3.99, 4.37) 

จัดเรียงใส่ถาด 0.15 727 + 18 * BETA(0.917, 1.42) 

แบ่งใส่ถาด 0.15 251 + 59 * BETA(0.694, 0.714) 

การบรรจุและติดฉลาก
ผลิตภัณฑ์ 

0.15 60 + 7 * BETA(0.774, 0.832) 
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4.3สร้างแบบจ าลองสถานการณ์โดยใช้ข้อมูลจากโปรแกรมอารีน่า (Arena) 

 ขั้นตอนต่อไปคือการเขียนแบบจ าลองสถานการณ์แบบเรียงตามล าดับการท างานด้วย
โปรแกรมอารีนา (Arena) จากนั้นจึงบันทึกข้อมูลการกระจายตัวทางสถิติของเวลาลงในแบบจ าลอง
สถานการณ์ที่สร้างขึ้นมา โดยแบบจ าลองสถานการณ์ที่ใช้แทนการท างานของการผลิตล า ไยอบแห้ง
สามารถแสดงได้ดังภาพ 4.11 

 

ภาพ 4.11 แสดงจ าลองสถานการณ์ของล าไยอบแห้ง 

 โดยสามารถอธิบายความสัมพันธ์และการท างานของแบบจ าลองสถานการณ์ โดยน า
แบบจ าลองสถานการณ์มาขยาย ซึ่งอธิบายได้ดังนี้ 

 

 

ภาพ 4.12 แสดงโมดูลกระบวนการก่อนอบล าไย 

 จากภาพ 4.12 จะเริ่มต้นจากการน าล าไยเข้ามาในโมดูล Create 5 ต่อไปยังโมดูล Process 
cutting skin เพ่ือท าการแกะเปลือกและคว้านเมล็ด จากนั้นต่อไปยังโมดูล Process cutting press 
เพ่ือน าล าไยจัดเรียงบนถาดส าหรับน าเข้าตู้อบ 
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ภาพ 4.13 แสดงโมดูล Create 5 

 

 

 

ภาพ 4.14 แสดงโมดูล Process cutting skin 
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ภาพ 4.15 แสดงโมดูล Process cutting press 

 

 

 

 

ภาพ 4.16 แสดงโมดูลที่เกี่ยวข้องกับการอบล าไย 

  

 จากภาพ 4.16 แสดงให้เห็นถึงความสัมพันธ์ของโมดูลที่เกี่ยวข้องกับการอบล าไย โดย
หลังจากจัดเรียงล าไยบนถาด จะน าไปรวมกันเป็น  Lot ในโมดูล Batch to car ต่อไปยังโมดูล 
Process heating เพ่ือท าการอบล าไย จากนั้นต่อไปยังโมดูล Separate 1 เพ่ือท าการแยกล าไย
อบแห้งที่ออกมาจากกระบวนอบเพ่ือใช้ในขั้นตอนต่อไป 
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ภาพ 4.17 แสดงโมดูล Batch to car 

 

 

ภาพ 4.18 แสดงโมดูล Process heating 
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ภาพ 4.19 แสดงโมดูล Separate 1 

 

ภาพ 4.20 แสดงโมดูลที่เกี่ยวข้องกันหลังจากการอบล าไย 

 

 จากภาพ 0.26 แสดงให้เห็นถึงความสัมพันธ์ของโมดูลเกี่ยวกับกระบวนการอบล าไยโดย
วัตถุดบิเคลื่อนที่เข้าโมดูล Process pick up ซึ่งเป็นตัวแทนของกระบวนการคัดแยก จากนั้นต่อไปที่
โมดูล Process packing and wait ซึ่งเป็นตัวแทนของกระบวนตาก จากนั้นไปที่โมดูล Process 
packing เป็นตัวแทนของกระบวนการบรรจุและติดฉลากผลิตภัณฑ์ 
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ภาพ 4.21 แสดงโมดูล Process pick up 

 

 

  

ภาพ 4.22 แสดงโมดูล Process packing 
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ตาราง 4.5 รายละเอียดกระบวนการผลิตของผลิตภัณฑ์มะเขือเทศอบแห้ง  

กระบวนการ
ผลิต 

จ านาวน
เครื่องจักร 

จ านวน
คนงาน 

รายละเอียดการท างาน 

เจาะเมล็ด 1 - น ามะเขือเทศใส่เครื่องเจาะเมล็ด เพ่ือน าเมล็ดออกจาก
มะเขือเทศ 

แช่น้ าปูนใส - 1 น ามะเขือเทศที่ได้รับการเจาะเมล็ดออกไปแล้วมาใส่ถุงที่มี
น้ ายาปูนใสถุงละ 5 กิโลกรัมแช่ค้างไว้1คืน 

การต้ม 3 - น าถุงมะเขือเทศท่ีได้รับการแช่น้ าปูนใสไว้แล้วหนึ่งคืนมา
แกะถุงแล้วน าไปต้มในกระทะที่มีระดับน้ าเดือด 100 องศา

เซลเซียส เป็นเวลา 5 นาที 
จัดเรียงใส่

ถาด 
- 0 น ามะเขือเทศที่ได้รับการต้มมาพักชั่วขณะจากนั้น เท

มะเขือเทศลงบนถาดและจัดเรียงให้เต็มถาดจ านวน 9 ถาด 
เพ่ือน าไปเข้าตู้อบ 

การอบ - 1 น ารถเข็นที่บรรจุถาดมะเขือเทศ เข้าตู้อบเป็นเวลา 16 
ชั่วโมง อบที่อุณหภูมิ 06-76 องศา 

ตากแห้ง - 1 น ามะเขือเทศที่ท าการอบเสร็จมาตากไว้ เพื่อให้มะเขขือ
เทศคลายตัวเป็นเวลา 1 คืน 

การบรรจุ
และติดฉลาก
ผลิตภัณฑ์ 

- 1 มะเขือเทศอบแห้งที่ตากแล้ว มาบรรจุลงกล่องกล่องละ 
566 กรัม และติดฉลากผลิตภัณฑ์ 

 

4.3 วิเคราะห์การกระจายตัวทางสถิติของข้อมูลในแต่ละกระบวนการ 

 หลังจากศึกษาขั้นตอนการผลิตผลิตภัณฑ์มะม่วงอบแห้งและได้ท าการบักทึกเวลาของ
กระบวนการซึ่งจะแสดงในภาคผนวก จากนั้นน าข้อมูลเวลาของกระบวนการมาวิเคราะห์การกระจาย
ตัวทางสถิติของข้อมูลเวลาของแต่ละกระบวนการ โดยใช้เครื่องมือ Input Analyzer โดยข้อมูลการ
กระจายตัวทางสถิติของข้อมูลเวลาและวิธีการวิเคราะห์จะแสดงดังตาราง 4.6 

ตาราง 4.6 การกระจายตัวทางสถิติของมะเขือเทศอบแห้ง 

กระบวนการผลิต P-Value การกระจายตัวทางสถิติ 
เจาะเมล็ด 0.15 10 + ERLA(1.06, 3) 

แช่น้ าปูนใส 0.15 62 + 18 * BETA(1.05, 1.03) 

การต้ม 0.638 300 + 40 * BETA(1.1, 0.939) 

จัดเรียงใส่ถาด 0.75 UNIF(120, 140) 

การบรรจุและติดฉลาก
ผลิตภัณฑ์ 

0.15 305 + EXPO(12.9) 
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 ขั้นตอนต่อไปคือการเขียนแบบจ าลองสถานการณ์แบบเรียงตามล าดับการท างานด้วย
โปรแกรมอารีนา (Arena) จากนั้นจึงบันทึกข้อมูลการกระจายตัวทางสถิติของเวลาลงในแบบจ าลอง
สถานการณ์ที่สร้างขึ้นมา โดยแบบจ าลองสถานการณ์ที่ใช้แทนการท างานของการผลิตมะเขือเทศ
อบแห้งสามารถแสดงได้ดังภาพ 4.23 

 

 

ภาพ 4.23 แสดงแบบจ าลองสถานการณ์ที่ใช้แทนกระบวนการผลิตมะเขือเทศอบแห้ง 

 

 โดยสามารถอธิบายความสัมพันธ์และการท างานของแบบจ าลองสถานการณ์ โดยน า
แบบจ าลองสถานการณ์มาขยาย ซึ่งอธิบายได้ดังนี้ 

 

ภาพ 4.24 แสดงโมดูลเกี่ยวข้องกับการน าเข้าวัตถุดิบและกระบวนการเจาะเมล็ด 

 

จากภาพ 4.24 เริ่มต้นด้วยการน าเข้าวัตถุดิบจากโมดูล Tomato ต่อไปยังโมดูล Process Jee เพ่ือท า
การเจาะเมล็ดออกจากมะเขือเทศ 
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ภาพ 4.25 แสดงโมดูล Create Tomato 

 

 

 

ภาพ 4.26 แสดงโมดูล Process Jee 
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ภาพ 4.27 แสดงเส้นทางท่ีวัตถุดิบผ่านกระบวนการแช่น้ าปูนใสและการต้ม 

 

จากภาพ 4.27 แสดงการเคลื่อนที่ของวัตถุดิบผ่านโมดูล Process hold seed และ Procress 
wait ซึ่งเป็นตัวแทนกระบวนการล้างและแช่น้ าปูใส จากนั้นต่อไปที่โมดูล Process Boiler ซึ่งแทน
กระบวนต้มมะเขอืเทศ 

 

 

  

ภาพ 4.28 แสดงโมดูล Process hold seed 
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ภาพ 4.29แสดงโมดูล Process wait 

 

 

 

ภาพ 4.30 แสดงโมดูล Process Boiler 
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ภาพ 4.31 แสดงการเคลื่อนที่ของวัตถุดิบผ่านกระบวนการจัดเรียงและการอบ 

 

 จากภาพ 4.31 แสดงการเคลื่อนที่ของวัตถุดิบผ่านโมดูล Process array ซึ่งเป็นกระบวนการ
จัดเรียงมะเขือเทศลงบนถาด จากนั้นต่อไปที่โมดูล Batch to car เพ่ือรวมวัตถุดิบเป็น Lot และต่อไป
ส่งต่อไปที่โมดูล Process heat ซึ่งท าหน้าที่ในการอบ และสุดท้ายวัตถุดิบเข้าสู่โมดูล Separate 1 
เพ่ือแยกวัตถุดิบเข้าสู่กระบวนการถัดไป 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพ 4.32 แสดงข้อมูลของโมดูล Process array 
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ภาพ 4.33 แสดงข้อมูลของโมดูล Process heating 

 

 

 

ภาพ 4.34 แสดงความสัมพันธ์ของการเคลื่อนที่ของวัตถุดิบผ่านกระบวนการตากและบรรจุ 

 

 จากภาพ 4.34 วัตถุดิบจะเข้าสู่โมดูล Process wait ท าหน้าที่แทนกระบวนตากมะเขือเทศ 
จากนั้นเข้าสู่โมดูล Process packing เป็นตัวแทนขั้นตอนของการบรรจุลงกล่องและติดฉลาก
ผลิตภัณฑ์ 
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ภาพ 4.35 แสดงโมดูล Process wait 

 

4.4 วิเคราะห์แบบจ าลองสถานการณ์เพื่อหาแนวทางการจัดตารางอบผลไม้ 

หลังจากการสร้างแบบจ าลองสถานการณ์เสร็จสิ้นแล้วขั้นตอนต่อไปคือการวิเคราะห์ว่ า
แบบจ าลองสถานการณ์นั้นสามารถใช้แทนสถานการณ์จริงหรือไม่ โดยวิธีการน าค่าที่ได้จาก
แบบจ าลลองสถานการณ์ ซึ่งท าการประมวลผลแบบจ าลองสถานการณ์ที่ได้ท าการสร้างขึ้นจ านวน
ทั้งหมด ดังนี้ กระบวนการผลิตมะม่วงอบแห้ง 434 รอบ ล าไย 50 รอบ มะเขือเทศ 87 รอบการท าซ้ า 
เนื่องจากเป็นจ านวนรอบที่ให้ค่าความแปรปรวนที่ความเชื่อมั่นร้อยละ 95 มีค่าต่ าที่สุด ซึ่งค านวณได้
ดังสมการ 4.1  

𝑅 =  𝑅0  × (
𝐻𝑜

𝐻
)              (4.1) 

  

 โดยที่ 𝑅   = จ านวนรอบที่เหมาะสม 

  𝑅0  = จ านวนรอบบที่ได้ก าหนดเบื้องต้น 

  𝐻0  = ค่า Half Width ที่โปรแกรมแสดงจากจ านวนรอบที่ก าหนด 

  𝐻  = ค่า Half Width ที่รับได ้
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4.5 สร้างแบบจ าลองสถานการณ์น าเสนอแนวทางการปรับปรุงตารางการอบ  

 หลังจากแบบจ าลองสถานกรณ์สมบูรณ์แล้วขั้นตอนต่อไป คือการน าข้อมูลของแบบจ าลองมา 

วิเคราะห์โดยโปรแกรมจะแสดงค่าต่างๆ ของแบบจ าลอง สถานการณ์ผ่านทางหน้าจอแสดงผล 

 4.6.1 วิเคราะห์ข้อมูลของแบบจ าลองสถานการณ์มะม่วงอบแห้ง 

 

  

 

ภาพ 4.36 แสดงข้อมูลของแบบจ าลองสถานการณ์มะม่วงอบแห้ง 

  จากภาพ 4.36 พบว่าเวลาโดยรวมของกระบวนการผลิตมะม่วงอบแห้งนั้นใช้เวลา
ทั้งหมดโดยเฉลี่ย 151.88 ชั่วโมง ซึ่งใกล้เคียงกับเวลาโดยรวมของกระบวนการผลิตจริงโดยมีค่า Half-
Width คือ 0.19413 จากการรันซ้ าทั้งหมด 434 รอบ 

4.6.2 วิเคราะห์ข้อมูลของแบบจ าลองสถานการณ์ล าไยอบแห้ง 

 

  

 

ภาพ 4.37 แสดงข้อมูลของแบบจ าลองสถานการณ์ล าไยอบแห้ง 

 

  จากภาพ 4.37 พบว่าเวลาโดยรวมของกระบวนการผลิตมะม่วงอบแห้งนั้นใช้เวลา
ทั้งหมดโดยเฉลี่ย 123.05 ชั่วโมง ซึ่งใกล้เคียงกับเวลาโดยรวมของกระบวนการผลิตจริงโดยมีค่า Half-
Width คือ 0.06365 จากการรันซ้ าทั้งหมด 50 รอบ 
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4.6.3 วิเคราะห์ข้อมูลของแบบจ าลองสถานการณ์มะเขือเทศอบแห้ง 

 

  

ภาพ 4.38 แสดงข้อมูลของแบบจ าลองสถานการณ์มะเขือเทศอบแห้ง 

   

  จากภาพ 4.38 พบว่าเวลาโดยรวมของกระบวนการผลิตมะเขือเทศอบแห้งนั้นใช้
เวลาทั้งหมดโดยเฉลี่ย 79.775 ชั่วโมง ซึ่งใกล้เคียงกับเวลาโดยรวมของกระบวนการผลิตจริงโดยมีค่า 
Half-Width คือ 0.08414 จากการรันซ้ าทั้งหมด 87 รอบ 

4.6.4 วิเคราะห์ข้อมูลของแบบจ าลองสถานการณ์มะม่วงอบแห้งและล าไยอบแห้งร่วมกัน 

  โดยแสดงตัวอย่างแบบจ าลองสถานการณ์ ดังภาพ 4.39 แบบจ าลองนี้ เป็น
แบบจ าลองที่ออกแบบให้มีการอบแบบใช้ตู้อบร่วมกัน ค่าที่ได้จากแบบจ าลองสถานการณ์  ดังภาพ 
4.40 แบบจ าจองสถานการณ์แบบจัดตู้อบใหม่โดยออกแบบให้มีการอบโดยแบ่งตู้อบของแต่ละชนิด 
ดังภาพ 4.41 และค่าที่ได้จากแบบจ าลองสถานการณ์แบบจัดตู้อบแบบแบ่งตู้อบ ดังภาพ 4.42 

  

 

ภาพ 4.39 แสดงแบบจ าลองสถานการณ์มะม่วงและล าใยอบแห้ง 
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ภาพ 4.40 แสดงค่าของแบบจ าลองสถานการณ์มะม่วงและล าใยอบแห้ง 

 

จากภาพ 4.40 พบว่าเวลาโดยรวมของกระบวนการผลิตมะม่วงอบแห้งและล าใย
อบแห้งนั้นใช้เวลารวมทั้งหมดโดยเฉลี่ย 150.04 ชั่วโมง โดยมีค่า Half-Width คือ 0.03022 จากการ
รันซ้ าทั้งหมด 10 รอบ 

 

  

 

ภาพ 4.41 แสดงแบบจ าลองสถานการณ์มะม่วงและล าใยอบแห้งแบบจัดตารางตู้อบใหม่แบบแบ่ง
ตู้อบ 

 

 

 

ภาพ 4.42 แสดงค่าของจ าลองสถานการณ์มะม่วงและล าใยอบแห้งแบบจัดตารางตู้อบใหม่ 

จากภาพ 4.42 พบว่าเวลาโดยรวมของกระบวนการผลิตมะม่วงและล าไยอบแห้ง
และล าใยอบแห้งแบบแบ่งตู้อบโดยให้ มะม่วงใช้ตู้อบจ านวณ 0 ตู้ และล าไยใช้ตู้อบจ านวณ 0 ตู้ โดย
ใช้เวลาทั้งหมดโดยเฉลี่ย 131.35 ชั่วโมง มีค่า Half-Width คือ 0.50999 จากการรันซ้ าทั้งหมด 10 
รอบ  

 

4.6.5 วิเคราะห์ข้อมูลของแบบจ าลองสถานการณ์มะม่วงอบแห้งและมะเขือเทศ
อบแห้งร่วมกัน 
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  โดยแสดงตัวอย่างแบบจ าลองสถานการณ์ ดังภาพ 4.43 แบบจ าลองนี้ เป็น
แบบจ าลองที่ออกแบบให้มีการอบแบบใช้ตู้อบร่วมกัน ค่าที่ได้จากแบบจ าลองสถานการณ์  ดังภาพ 
4.44 แบบจ าจองสถานการณ์แบบจัดตู้อบใหม่โดยออกแบบให้มีการอบโดยแบ่งตู้อบของแต่ละชนิด 
ดังภาพ 4.45 และค่าที่ได้จากแบบจ าลองสถานการณ์แบบจัดตู้อบใหม่ ดังภาพ 4.46 

 

 

ภาพ 4.43 แสดงแบบจ าลองสถานการณ์มะม่วงและมะเขือเทศอบแห้งแบบใช้ตู้อบร่วมกัน 

   

 

 

 

ภาพ 4.44 แสดงค่าของแบบจ าลองสถานการณ์มะม่วงและมะเขือเทศอบแห้งแบบใช้ตู้อบร่วมกัน 

 

จากภาพ 4.40 พบว่าเวลาโดยรวมของกระบวนการผลิตมะม่วงและมะเขือเทศ
อบแห้งแบบใช้ตู้อบร่วมกันนั้น ใช้เวลาทั้งหมดโดยเฉลี่ย 175.91 ชั่วโมง มีค่า Half-Width คือ 
0.26987 จากการรันซ้ าทั้งหมด 10 รอบ 
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ภาพ 4.45 แสดงแบบจ าลองสถานการณ์มะม่วงและมะเขือเทศอบแห้งแบบแบ่งตู้อบ 

 

 

 

ภาพ 4.46 แสดงค่าของจ าลองสถานการณ์มะม่วงและมะเขือเทศอบแห้งแบบแบ่งตู้อบ 

 

จากภาพ 4.46 พบว่าเวลาโดยรวมของกระบวนการผลิตมะม่วงและมะเขือเทศอบแห้งแบบ
แบ่งตู้อบ โดยมะม่วงใช้ตู้อบ 3 ตู้ส่วนมะเขือเทศใช้ 5 ตู้ ใช้เวลาทั้งหมดโดยเฉลี่ย 176.09 ชั่วโมง ซึ่งมี
ค่า Half-Width คือ 0.04517 จากการรันซ้ าทั้งหมด 10 รอบ  

4.6.6 วิเคราะห์ข้อมูลของแบบจ าลองสถานการณ์ล าใยอบแห้งและมะเขือเทศ
อบแห้งร่วมกัน 

  โดยแสดงตัวอย่างแบบจ าลองสถานการณ์ท่ีออกแบบให้มีการอบแบบใช้ตู้อบร่วมกัน 
ดังภาพ 4.47  ค่าที่ได้จากแบบจ าลองสถานการณ์แบบใช้ตู้อบบร่วมกัน ดังภาพ 4.48 แบบจ าจอง
สถานการณ์แบบจัดตู้อบใหม่โดยออกแบบให้มีการอบโดยแบ่งตู้อบของแต่ละชนิด ดังภาพ 4.49 และ
ค่าท่ีได้จากแบบจ าลองสถานการณ์แบบแบ่งตู้อบ ดังภาพ 4.50 

 

 

ภาพ 4.47 แสดงแบบจ าลองสถานการณ์ล าไยและมะเขือเทศอบแห้งแบบใช้ตู้อบร่วมกัน 
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ภาพ 4.48 แสดงค่าของแบบจ าลองสถานการณ์ล าใยและมะเขือเทศอบแห้งแบบใช้ตู้อบร่วมกัน 

 

จากภาพ 4.48 พบว่าเวลาโดยรวมของกระบวนการผลิตล าไยและมะเขือเทศอบแห้ง
แบบใช้ตู้อบร่วมกัน ใช้เวลารวมทั้งหมดโดยเฉลี่ย 125.98 ชั่วโมง ค่า Half-Width คือ 0.02126 จาก
การรันซ้ าทั้งหมด 10 รอบ 

 

  

 

 

ภาพ 4.49 แสดงแบบจ าลองสถานการณ์ล าไยและมะเขือเทศอบแห้งแบบแบ่งตู้อบ 

 

 

 

 

ภาพ 4.50 แสดงค่าของจ าลองสถานการณ์ล าไยและมะเขือเทศอบแห้งแบบแบ่งตู้อบ 

 

จากภาพ 4.56 พบว่าเวลาโดยรวมของกระบวนการผลิตล าไยและมะเขือเทศอบแห้งแบบแบ่ง
ตู้อบ โดยล าไยใช้ตู้อบจ านวน 0 ตู้ และมะเขือเทศใช้ตู้อบจ านวน 0 ตู้ ใช้เวลารวมทั้งหมดโดยเฉลี่ย 
125.98 ชั่วโมง มีค่า Half-Width คือ 0.02126 จากการรันซ้ าทั้งหมด 10 รอบ  

4.6.7 วิเคราะห์ข้อมูลของแบบจ าลองสถานการณ์มะม่วง, มะเขือเทศและล าไย
อบแห้งร่วมกัน 
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  โดยแสดงตัวอย่างแบบจ าลองสถานการณ์อบของทั้งสามชนิดแบบใช้ตู้อบร่วมกัน ดัง
ภาพ 4.51 ค่าที่ ได้จากแบบจ าลองสถานการณ์แบบใช้ตู้อบร่วมกัน  ดังภาพ 4.52 แบบจ าจอง
สถานการณ์แบบแบ่งตู้อบ ดังภาพ 4.53 และค่าที่ได้จากแบบจ าลองสถานการณ์แบบแบ่งตู้อบ ดังภาพ 
4.54 

 

 

 

ภาพ 4.51 แสดงแบบจ าลองสถานการณ์มะม่วง,มะเขือเทศและล าไยอบแห้งร่วมกัน 

   

 

 

 

ภาพ 4.52 แสดงค่าของแบบจ าลองสถานการณ์มะม่วง,มะเขือเทศและล าไยอบแห้งร่วมกันแบบ
ใช้ตู้อบร่วมกัน 

 

จากภาพ 4.52 พบว่าเวลาโดยรวมของกระบวนการผลิตมะม่วงและมะเขือเทศและ
ล าไยอบแห้งพร้อมกันโดยใช้ตู้อบร่วมกันนั้น ใช้เวลาทั้งหมดโดยเฉลี่ย 229.62 ชั่วโมง มีค่า Half-
Width คือ 0.04676 จากการรันซ้ าทั้งหมด 10 รอบ 
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ภาพ 4.53 แสดงแบบจ าลองสถานการณ์มะม่วง,มะเขือเทศและล าไยอบแห้งร่วมกันแบบแบ่งตู้อบ 

 

 

 

ภาพ 4.54 แสดงค่าของแบบจ าลองสถานการณ์มะม่วง,มะเขือเทศและล าไยอบแห้งร่วมกันแบบ
แบ่งตู้อบ 

จากภาพ 4.54 พบว่าเวลาโดยรวมของกระบวนการผลิตมะม่วง,มะเขือเทศและล าไย
อบแห้งร่วมกันแบบแบ่งตู้อบ โดยให้มะม่วงใช้ตู้อบจ านวน 0 ตู้ มะม่วงใช้ตู้อบจ านวน 2 ตู้ และมะเขือ
เทศใช้ตู้อบจ านวน 2 ตู้ นั้นใช้เวลาทั้งหมดโดยเฉลี่ย 234.79 ชั่วโมง โดยมีค่า Half-Width คือ 
0.54457 จากการรันซ้ าทั้งหมด 10 รอบ  
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บทท่ี 5  

 

สรุปผลและข้อเสนอแนะ 

 

จากผลการด าเนินงานวิจัยที่ได้กล่าวมาในบทที่แล้วท าให้สามารถวิเคราะห์แนวทางที่
เหมาะสมในการจัดตารางตู้อบของผลิตภัณฑ์ผลไม้อบแห้ง รวมทั้งผลการเปรียบเทียบในการน าแนว
ทางการจัดตารางตู้อบที่ผลิตได้หลากชนิดไปทดลองใช้ในแบบจ าลองสถานการณ์กับผลก่อนการ
ปรับปรุงและส าหรับบทนี้จะเป็นการสรุปผลที่ได้จากงานวิจัยมาทั้งหมด เพ่ือให้งานวิจัยนั้นบรรลุตาม
วัตถุประสงค์หลักของการท างานวิจัย รวมทั้งข้อเสนอแนะในการปรับปรุงกระบวนการผลิต ปญหา
และอุปสรรคที่พบในการท างานวิจัย ซึ่งมีรายละเอียดดังต่อไปนี้ 

 

5.1 สรุปผลการศึกษากระบวนการผลิตผลิตภัณฑ์ผลไม้อบแห้ง 

 จากการด าเนินงานวิจัย การจัดตารางตู้อบผลิตภัณฑ์ผลไม้อบแห้ง ท าให้ทราบถึงการใช้ตู้อบ
ที่ยังไม่ได้ใช้เต็มประสิทธิภาพจึงได้ท าการเก็บข้อมูลกระบวนการผลิตเพ่ือหาแนวทางในการเพ่ิม
ประสิทธิภาพในการใช้ตู้อบ จากการเก็บข้อมูลในระบบจริงท าให้ทราบกระบวนการผลิตของ
ผลิตภัณฑ์แต่ละชนิดและท าการจับเวลาในทุกกระบวนการผลิตและน าข้อมูลเหล่านี้ไปใช้ในการสร้าง
แบบจ าลองสถานการณ์ต่อไป 

 

5.2 สรุปผลการสร้างแบบจ าลองสถานการณ์ 

 จากการสร้างแบบจ าลองสถานการณ์ด้วยโปรแกรมอารีนา (Arena) ท าให้ได้แบบจ าลอง
สถานการณ์ที่สามารถน ามาวิเคราะห์กระบวนการผลิตของผลิตภัณฑ์ผลไม้อบแห้งทั้งสามชนิดได้ โดย
มีการตรวจสอบความถูกต้องของแบบจ าลองโดยการเปรียบเทียบชั่วโมงการผลิตรวมของกระบวนการ
จริง และข้อมูลที่แสดงจากโปรแกรมแบบจ าลองสถานการณ์ ซึ่งจากการตรวจสอบพบว่าค่าที่ได้จาก
สถานนะการจริงมีความใกล้เคียงกับค่าที่ได้จากโปรแกรมแบบจ าลองสถานการณ์ โดยอยู่ในช่วงความ
เชื่อมั่นร้อยละ 95 ไม่มีความแตกต่างกันจึงสามารถน าแบบจ าลองสถานการณ์มาใช้แทนสถานการณ์
จริงได ้ 
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5.3 สรุปแนวทางการจัดตารางการอบผลไม้อบแห้ง 

 เมื่อได้สร้างแบบจ าลองสถานการณ์มาแล้วจึงน ามาหาแนวทางในการจัดตารางตู้อบผลไม้
อบแห้ง สามารถสรุปแนวทางได้ดังนี้ 

 วิธีที่ 1 : ท าการผลิตผลไม้อบแห้งเพียงชนิดเดียวทีละกระบวนการผลิตแบบเดิม 

 วิธีที่ 2 : ท าการผลิตผลไม้อบแห้งทีละสองชนิด ดังนี้ มะม่วงและล าไย, มะม่วงและมะเขือเทศ
, ล าไยและมะเขือเทศ เพ่ือจัดการตารางการน าเข้าผลไม้แต่ละชนิดเพ่ือเข้าการอบโดยที่มีตู้อบแปดตู้
จึงสามารถจัดสรรล าดับการอบผลไม้ได้อย่างอิสระและดูค่าข้อมูลที่ได้จากโปรแกรมจ าลองสถานการณ์
เพ่ือตรวจสอบว่าสามารถท าได้จริง  

 วิธีที่3 : ท าการผลิตผลไม้อบแห้งทั้งสามชนิดพร้อมกันและดูแนวทางความเป็นไปได้ ในการ
จัดการตารางการน าเข้าผลไม้แต่ละชนิดเพ่ือเข้าการอบโดยที่มีตู้อบแปดตู้จึงสามารถจัดสรรล าดับการ
อบผลไม้ได้อย่างอิสระและดูค่าข้อมูลที่ได้จากโปรแกรมจ าลองสถานการณ์เพ่ือตรวจสอบว่าสามารถ
ท าได้จริง  

 เมื่อน าแนวทางการปรับปรุงต่างจากแบบจ าลองสถานการณ์แล้วสามารถสรุปได้ ว่า วิธีการที่
น่าสนใจเพื่อน ามาเป็นแนวทางในการผลิตจริงคือ วิธีที่ 3 เพราะสามารถใช้ตู้อบได้อย่างมีประสิทธิภาพ
มากที่สุดในหนึ่งรอบกระบวนการผลิต ในการท าผลไม้อบแห้งได้ถึงสามชนิดพร้อมกันในหนึ่ง
กระบวนการผลิตเพราะมีการไหลเวียนของวัตถุดิบตลอดเวลาและมีประสิทธิภาพและเวลาโดยรวม
เฉลี่ยมีค่าอยู่ในช่วงที่ไม่ห่างจากกระบวนการผลิต วิธีอ่ืนๆมากนัก 

 

5.4 ปัญหาและอุปสรรค 

ตาราง 5.1 ปัญหาและแนวทางการแก้ไข 

ปัญหาและอุปสรรค แนวทางการแก้ไข 
1 .บา งกระบวนการมี เ วล าการผลิ ตที่ ไ ม่
สม่ าเสมอท าให้การสร้างแบบจ าลองเป็นไปได้
ด้วยความยากล าบาก 

1. แก้ไขแบบจ าลองสถานการณ์โดยการเพ่ิม
เวลาหยุดงานตามความเหมาะสม 

2. บางครั้งไม่สามารถเก็บข้อมูลได้เนื่องจากไม่มี
การท างานในส่วนที่ต้องการเก็บข้อมูล 

2. ต้องมีการนัดหมายกับทางโรงงานล่วงหน้า
ก่อนมีการเข้าไปเก็บข้อมูล 

3. การท างานของพนักงานค่อนข้างไม่เป็น
มาตรฐานท าให้เกิดอุปสรรคในการเก็บข้อมูล 
 

3. น าวิธีการท างานของพนักงานส่วนใหญ่มา
เป็นมาตราฐานในการท างาน 
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ภาคผนวก ก 
 

ข้อมูลเวลาเพ่ือใช้ในการสร้างแบบจ าลองโปรแกรม อารีน่า (Arena) 
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ข้อมูลเวลาเพื่อการสร้างแบบจ าลองสถานการณ์ 

 

ตาราง ก-1 ผลิตภัณฑ์มะม่วงอบแห้ง (ปอกเปลือก) 

 มะม่วง 

จ านวนการจับเวลา 

ระยะเวลาของการ
ปอกเปลือกคนที1่ 

(วินาที) 

ระยะเวลาของการ
ปอกเปลือกคนที2่ 

(วินาที) 

ระยะเวลาของการ
ปอกเปลือกคนที3่ 

(วินาที) 

ระยะเวลาของการ
ปอกเปลือกคนที4่ 

(วินาที) 
1 7.32 8.4 7.54 8.02 
2 7.65 7.92 8.12 7.44 
3 7.24 8.05 8.24 7.78 
4 7.33 7.78 7.85 7.52 
5 7.42 8.34 8.1 7.85 
6 7.98 8.21 7.69 8.05 
7 8.01 7.67 8.1 7.82 
8 7.32 8.4 7.54 8.02 
9 7.65 7.92 8.12 7.44 
10 7.24 8.05 8.24 7.78 
11 7.33 7.78 7.85 7.52 
12 7.42 8.34 8.1 7.85 
13 7.98 8.21 7.69 8.05 
14 8.01 7.67 8.1 7.82 
15 7.54 8.43 7.48 7.86 
16 7.82 8.13 7.82 8.04 
17 7.33 8.18 7.58 7.66 
18 7.87 7.53 7.82 7.48 
19 7.21 8.20 7.64 8.14 
20 7.25 7.65 7.69 7.59 

เวลาเฉลี่ยต่อคน 7.38 7.81 8.02 7.41 
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ตาราง ก-2 ผลิตภัณฑ์มะม่วงอบแห้ง (จัดเรียงบนถาด) 

มะม่วงอบแห้ง 
จ านวน
การจับ
เวลา 

ถาดที1่ 

(วินาที) 

ถาดที2่ 

(วินาที) 

ถาดที3่ 

(วินาที) 

ถาดที4่ 

(วินาที) 

ถาดที5่ 

(วินาที) 

ถาดที6่ 

(วินาที) 

ถาดที7่ 

(วินาที) 

ถาดที8่ 

(วินาที) 

ถาดที่9 

(วินาที) 
เวลาเฉลี่ย
ทั้งหมด 

1 712.78 723.44 712.72 710.35 760.56 764.74 754.47 768.97 750.4 739.83 

2 722.46 708.02 720.4 723.12 727.42 730.21 732.06 766.85 780.45 734.55 
3 709.34 711.62 737.18 740.44 714.46 749.99 752.56 786.94 740.79 738.15 

4 735.82 732.91 754.45 726.9 748.08 741.22 731.77 722.99 736.97 736.79 

5 752.82 728.81 724.57 728.59 733.1 724.47 711.33 721.91 747.2 730.31 

6 740.65 738.89 741.69 755.14 731.77 727.13 734.5 726.82 733.11 736.63 

7 723.38 729.65 728.97 749.44 728.18 750.49 732.01 755.16 750.96 738.69 

8 715.84 728.27 737.91 727.37 732.87 737.92 724.45 720.86 748.18 730.41 
9 733.5 711.95 728.05 748.11 735.54 722.09 745.76 715.58 731.35 730.21 

10 737.93 717.45 745.06 737.21 754.93 710.64 710.46 710.71 748.22 730.29 

11 711.98 750.88 751.86 728.68 718.84 747.76 716.45 714.87 716.54 728.65 

12 712.77 727.64 710.24 755.13 752.79 735.62 730.38 711.25 712.62 727.60 

13 721.54 729.1 713.5 734.98 740.36 718.35 752.26 736.26 711.87 728.69 

14 719.65 752.82 749.18 732.01 754.29 755.27 733.65 753.33 754.42 744.96 
15 715.81 739.33 729.91 719.88 729.99 729.93 745.58 739.53 743.31 732.59 

16 740.22 753.18 721.47 716.78 712.42 755.04 734.39 716.64 751.17 733.48 

17 722.9 755.17 715.97 726.53 735.99 754.63 721.33 716.68 723.79 730.33 

18 735.74 744.75 735.98 738.1 726.39 710.64 745.54 712.86 736.53 731.84 

19 742.73 750.88 740.13 741.82 752.16 733.35 729.86 746.97 735.24 741.46 

20 747.89 717.97 733.21 735.03 754.52 722.5 739.02 727.02 742.77 735.55 
เวลา
เฉลี่ย

ต่อถาด 727.79 732.64 731.62 733.78 737.23 736.10 733.89 733.61 739.79   
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ตาราง ก-3 ผลิตภัณฑ์ล าใยอบแห้ง (คว้านเมล็ด) 

 

 

 

 

 

 

 

 

 ล าไย 

จ านวนการจับเวลา 

ระยะเวลาของ
การคว้านเมล็ด

คนที1่ 
(วินาที) 

ระยะเวลาของ
การคว้านเมล็ด

คนที่2 
(วินาที) 

ระยะเวลาของ
การคว้านเมล็ด

คนที3่ 
(วินาที) 

ระยะเวลาของ
การคว้านเมล็ด

คนที4่ 
(วินาที) 

1 3.67 3.32 2.92 3.71 
2 3.48 4.13 3.17 3.24 
3 3.57 3.17 3.22 3.82 
4 3.89 4.07 3.32 4.22 
5 3.47 4.2 3.96 3.27 
6 3.61 3.97 3.76 4.04 
7 4.12 3.79 3.07 4.14 
8 4.05 4.01 4.05 3.85 
9 3.74 3.71 3.92 4.12 
10 3.84 3.79 3.08 3.46 
11 4.02 3.51 3.41 3.82 
12 4.04 3.75 3.97 4.07 
13 3.75 4.05 3.84 3.96 
14 4.02 3.81 3.84 3.66 
15 3.51 3.76 2.95 3.86 
16 3.52 3.43 3.27 3.17 
17 3.75 3.63 3.42 4.06 
18 3.52 4.08 3.23 3.6 
19 3.83 3.45 3.12 4.07 
20 4.11 4.12 4.23 3.95 

เวลาเฉลี่ยต่อคน 4.05 4.01 4.05 3.85 
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ตาราง ก-4 ผลิตภัณฑ์ล าใยอบแห้ง (จัดเรียงบนถาด) 

 

 

 

 

 

 

 

ล าไยอบแห้ง 
จ านวน
การจับ
เวลา 

ถาดที1่ 

(วินาที) 

ถาดที2่ 

(วินาที) 

ถาดที3่ 

(วินาที) 

ถาดที4่ 

(วินาที) 

ถาดที5่ 

(วินาที) 

ถาดที6่ 

(วินาที) 

ถาดที7่ 

(วินาที) 

ถาดที8่ 

(วินาที) 

ถาดที่9 

(วินาที) 

เวลา
เฉลี่ย

ทั้งหมด 

1 367.56 369.88 369.97 372.44 376.29 367.78 407.89 401.59 410.34 382.64 

2 360.12 340.07 387.09 399.56 375.67 389.12 412.65 407.98 430.67 389.21 

3 369.89 370.34 367.09 349.87 365.98 419.99 454.95 417.01 436.56 394.63 

4 364.51 376.98 383.71 389.35 389.10 380.07 414.47 430.94 454.68 398.20 

5 381.62 371.63 374.18 361.36 383.63 363.34 408.31 441.7 422.83 389.84 

6 361.95 388.32 365.11 387.35 373.02 385.3 418.93 440.4 427.82 394.24 

7 383.97 381.87 363.43 375.63 382.1 373.28 431.85 437.95 441.11 396.80 

8 377.14 371.79 384.9 385.97 361.07 370.62 451.57 403.28 410.02 390.71 

9 388.34 373.52 363.36 378.92 364.97 385.91 409.45 414.62 431.55 390.07 

10 364.8 383.35 363.6 379.14 369.7 382.27 414.46 408.29 406.55 385.80 

11 374.51 376.46 363.67 383.13 361.78 384.34 448.81 431.29 445.71 396.63 

12 368.31 367.76 370.16 362.32 379.75 364.13 433.64 438.78 422.18 389.67 

13 374.42 363.29 367.99 378.72 362.5 386.87 439.31 429.44 443.44 394.00 

14 387.27 379.94 374.85 378.41 363.76 386.45 439.4 422.21 423.07 395.04 

15 379.86 360.08 374.21 372.9 366.43 365.71 413.74 422.89 415.85 385.74 

16 388.02 370.71 373.77 368.49 389.28 386.57 444.35 412.96 442.8 397.44 

17 381.73 360.64 369.64 378.81 367.51 373.66 420.49 450 422.43 391.66 

18 386.38 381.04 383.35 388.03 388.88 369.52 412.43 444.46 434.66 398.75 

19 360.76 371.15 367.36 386.47 361.33 377.11 420.05 428.9 411.64 387.20 

20 389.81 370.26 389.91 389.39 389.2 388.45 412.54 419.6 438.36 398.61 
เวลา

เฉลี่ยต่อ
ถาด 375.55 371.45 372.87 378.31 373.60 380.02 425.46 425.21 428.61  
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ตาราง ก-5 ผลิตภัณฑ์มะเขือเทศอบแห้ง              ตาราง ก-6 ผลิตภัณฑ์มะเขือเทศอบแห้ง                  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

จับเวลา
คร้ังท่ี 

คนที1่ 
(วินาที) 

คนที่2 
(วินาที) 

คนที3่ 
(วินาที) 

1 1.12 1.18 1.16 
2 1.14 1.15 1.13 
3 1.11 1.11 1.07 
4 1.10 1.11 1.05 
5 1.04 1.07 1.07 
6 1.01 1.17 1.06 
7 1.14 1.06 1.18 
8 1.00 1.09 1.08 
9 1.15 1.10 1.19 
10 1.01 1.16 1.19 
11 1.09 1.14 1.14 
12 1.03 1.06 1.06 
13 1.09 1.04 1.18 
14 1.15 1.11 1.08 
15 1.13 1.07 1.04 
16 1.04 1.13 1.12 
17 1.15 1.19 1.07 
18 1.06 1.06 1.10 
19 1.11 1.14 1.09 
20 1.14 1.10 1.10 

จับเวลา
คร้ังท่ี 

การจิ้มเมล็ด
(วินาที) 

1 15 
2 12 
3 14 
4 13 
5 15 
6 12 
7 11 
8 12 
9 10 
10 14 
11 12 
12 11 
13 10 
14 16 
15 14 
16 15 
17 13 
18 12 
19 11 
20 14 
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ตาราง ก-7 ผลิตภัณฑ์มะเขือเทศอบแห้ง (จัดเรียงบนถาด) 

จับเวลา
คร้ังท่ี 

ถาด1 
(นาท)ี 

ถาด2 
(นาท)ี 

ถาด3 
(นาท)ี 

ถาด4 
(นาท)ี 

ถาด5 
(นาท)ี 

ถาด6 
(นาท)ี 

ถาด7 
(นาท)ี 

ถาด8 
(นาท)ี 

ถาด9 
(นาท)ี 

1 2.01 2.01 2.12 2.05 2.01 2:10 2:02 2:12 2:00 
2 2.08 2.15 2.13 2.14 2.01 2:03 2:03 2:11 2:08 
3 2.01 2.17 2.03 2.09 2.18 2:16 2:10 2:16 2:16 
4 2.02 2.15 2.01 2.04 2.07 2:18 2:06 2:17 2:17 
5 2.13 2.06 2.12 2.15 2.08 2:12 2:14 2:12 2:14 
6 2.12 2.03 2.02 2.05 2.04 2:10 2:08 2:01 2:08 
7 2.16 2.06 2.04 2.17 2.16 2:19 2:00 2:15 2:05 
8 2.06 2.12 2.15 2.15 2.05 2:08 2:16 2:07 2:05 
9 2.14 2.16 2.00 2.11 2.10 2:13 2:02 2:12 2:12 
10 2.04 2.10 2.03 2.09 2.03 2:18 2:00 2:09 2:13 
11 2.08 2.02 2.10 2.16 2.00 2:17 2:01 2:12 2:14 
12 2.16 2.15 2.10 2.10 2.18 2:16 2:07 2:17 2:09 
13 2.19 2.16 2.18 2.11 2.12 2:15 2:15 2:06 2:10 
14 2.12 2.09 2.10 2.08 2.14 2:07 2:06 2:02 2:08 
15 2.04 2.19 2.00 2.18 2.14 2:00 2:12 2:05 2:03 
16 2.04 2.09 2.17 2.09 2.06 2:12 2:05 2:06 2:14 
17 2.19 2.15 2.06 2.03 2.06 2:19 2:18 2:13 2:09 
18 2.04 2.03 2.00 2.15 2.05 2:05 2:08 2:01 2:19 
19 2.05 2.08 2.04 2.15 2.06 2:10 2:02 2:09 2:02 
20 2.01 2.06 2.11 2.19 2.13 2:11 2:18 2:01 2:00 
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ตาราง ก-8 ผลิตภัณฑ์มะเขือเทศอบแห้ง (ต้มในกระทะ) 

จับเวลาคร้ังท่ี 
กระทะที1่ 
(วินาที) 

กระทะที2่ 
(วินาที) 

กระทะที3่ 
(วินาที) 

1 5.02 5.12 5.02 
2 5.10 5.17 5.01 
3 5.31 5.05 5.09 
4 5.14 5.23 5.19 
5 5.25 5.39 5.28 
6 5.23 5.18 5.12 
7 5.07 5.24 5.05 
8 5.36 5.37 5.23 
9 5.10 5.37 5.38 
10 5.12 5.15 5.38 
11 5.08 5.09 5.38 
12 5.31 5.05 5.28 
13 5.37 5.06 5.23 
14 5.16 5.25 5.38 
15 5.30 5.37 5.31 
16 5.10 5.38 5.34 
17 5.21 5.18 5.28 
18 5.11 5.09 5.14 
19 5.10 5.03 5.00 
20 5.13 5.02 5.15 
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ภาคผนวก ข 

ข้อมูการกระจายตัวทางสถิติของข้อมูลเวลา 

 

ภาคผนวกนี้จะแสดงถึงข้อมูลการกระจายตัวทางสถิติของข้อมูลเวลาที่ถูกวิเคราะห์โดยโปรแกรม 
Input Analyzer เพ่ือน าค่าไปเป็นข้อมูลแบบจ าลองสถานการณ์ โดยมีการน าข้อมูลดิบมาวิเคราะห์
ดังนี้ 
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1. เวลาการท างานในกระการปอกเปลือกมะม่วง มีค่าการกระจายตัวทางสกิติเป็น 7.68 + 1.08 * 
BETA(2.05, 2.02) 

 

ภาพ ข-1 การกระจายตัวทางสถิติของกระบวนการปอกเปลือกมะม่วง 

 

2. เวลาการท างานในกระบวนการหั่นและจัดเรียงมะม่วง มีค่าการกระจายตัวทางสถิติเป็น 
NORM(730, 15.3) 

 

ภาพ ข-2 การกระจายตัวทางสถิติของกระการหั่นและจัดเรียงมะม่วง 
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3. เวลาการท างานในกระบวนการคัดแยกมะม่วงอบแห้ง มีค่าการกระจายตัวทางสติเป็น 520 + 80 * 
BETA(6.767, 6.753) 

 

 

ภาพ ข-3 การกระจายตัวทางสถิติของกระบวนการคัดแยกมะม่วง 

 
4. เวลาการท างานในกระบวนการบรรจุและติดฉลากผลิตภัณฑ์มะม่วงอบแห้ง มีค่าการกระจายตัว
เป็น 75 + LOGN(3.63, 3.5) 

 

 

ภาพ ข-4 การกระจายตัวทางสถิติของกระบวนการบรรจุและติดฉลากผลิตภัณฑ์มะม่วงอบแห้ง 
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5. เวลาการท างานในกระบวนการปอกเปลือกและคว้านเมล็ดล าไย มีค่าการกระจายตัวเป็น 
TRIA(2.78, 3.99, 0.37) 

 

 

ภาพ ข-5 การกระจายตัวทางสถิติของกระบวนการปอกเปลือกและคว้านเมล็ดล าไย 

 

0. เวลาการท างานในกระบวนการจัดเรียงล าไย มีค่าการกระจายตัวเป็น 306 + LOGN(57.1, 05.5) 

 

 

ภาพ ข-6 การกระจายตัวทางสถิติของกระบวนการจัดเรียงล าไย 
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7. เวลาการท างานในกระบวนการคัดแยกล าไย มีค่าการกระจายตัวเป็น 251 + 59 * BETA(6.090, 
6.710) 

 

 

ภาพ ข-7 การกระจายตัวทางสถิติของกระบวนการคัดแยกล าไย 

 

8. เวลาการท างานในกระบวนการบรรจุและติดฉลากผลิตภัณฑ์ล าไย มีค่าการกระจายตัวเป็น 06 + 7 
* BETA(6.770, 6.832) 

 

 

ภาพ ข-8 การกระจายตัวทางสถิติของกระบวนการบรรจุและติดฉลากผลิตภัณฑ์ล าไย 
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9. เวลาการท างานในกระบวนการเจาะเมล็ดมะเขือเทศ มีค่าการกระจายตัวเป็น  9.5 + 7 * 
BETA(1.50, 1.70) 

 

 

ภาพ ข-9 การกระจายตัวทางสถิติของกระบวนเจาะเมล็ดมะเขือเทศ 

 

16. เวลาท างานในกระบวนการแช่น้ าปูนใสของมะเขือเทศ มีค่าการกระจายตัวเป็น 06 + 26 * 
BETA(1.19, 1.20) 

 

 
ภาพ ข-10 การกระจายตัวทางสถิติของกระบวนการแช่น้ าปูนใส 
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11.เวลาท างานในกระบวนการต้มมะเขือเทศ มีค่าการกระตัวเป็น 366 + 06 * BETA(1.1, 6.939) 

 

 

ภาพ ข-11 การกระจายตัวของกระบวนการต้มมะเขือเทศ 

 

12. เวลาท างานในกระบวนการจัดเรียงมะเขือเทศเป็น UNIF(126, 106) 

 

  

 ภาพ ข-12 การกระจายตัวของกระบวนการจัดเรียงมะเขือเทศ 
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13. เวลาท างานในกระบวนการบรรจุและติดฉลากผลิตภัณฑ์มะเขือเทศอบแห้ง มีค่าการกระจายตัว
เป็น 365 + EXPO(12.9) 

 

 

ภาพ ข-13 การกระจายตัวที่สถิติของกระบวนการบรรจุและติดฉลากผลิตภัณฑ์ของมะเขือเทศ
อบแห้ง 
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ประวัติผู้เขียน 

 

ชื่อ-สกุล : นายภูชิสส์ รักสัตย์  

ชื่อเล่น :  ปาม 

รหัสนักศึกษา : 580610604 

วันเกิด :  23 เมษยน 2539 

ที่อยู่ :  9/5 หมู่ที่ 4 ต าบลหนองหอย อ าเภอเมือง  

จังหวัดเชียงใหม่ 50000  

Email :   puchit.chit23@gmail.com 

ประวัติการศึกษา : 

 ระดับมัธยมปลาย  โรงเรียนวารีเชียงใหม่ 

 ปัจจุบัน    คณะวิศวกรรมศาสตร์ มหาวิทยาลัยเชียงใหม่ 

 สถานที่ฝึกงาน : แปดลิ้วเครื่องเย็น (1994) เชียงใหม่ 

 

ชื่อ-สกุล :  นายอาณกร นิทัศน์วิจิตร 

ชื่อเล่น :   อาร์ม 

รหัสนักศึกษา :  590610363 

วันเกิด :   4 กุมภาพันธ์ 2539 

ที่อยู่ :   79/1 หมู่ 4 ต าบล สารภี อ าเภอ สารภี  

 จังหวัดเชียงใหม่ 50140 

Email :    n_anakorn@hotmail.com 

ประวัติการศึกษา : 

 ระดับมัธยมปลาย  โรงเรียนมงฟอร์ตวิทยาลัย แผนกมัธยม 

 ปัจจุบัน    คณะวิศวกรรมศาสตร์ มหาวิทยาลัยเชียงใหม่ 

 สถานที่ฝึกงาน :  ยังไม่ได้ฝึกงาน 
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